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Introduction

atomes is a cross-platform Free (Open Source) computational material science tool
box. It regroups a comprehensive panel of specialized edition tools, several assistants
dedicated to the preparation of numerical experiments, and, a large number of physico-
chemical analysis. Advanced visualization utilities and capabilities being available at
each stage of the process atomes introduces innovative 3D rendering possibilities and
intuitive applications of the calculation results.

atomes is designed to analyze, to visualize and to create/edit large three-dimensional
atomic scale models, and can handle MD trajectories from hundreds of thousands,
up to millions, of atoms. Using OpenMP parallelization, file processing, coordination
and physico-chemical analysis make use of the advantages of modern CPUs and their
multiple cores. Consequently when importing atomic coordinates several properties
are analyzed on the fly regardless of the size, in number of atoms or MD steps, and the
periodicity of the system.
atomes offers a workspace that allows to have many projects opened simultaneously.
The different projects in the workspace can exchange data: analysis results, atomic
coordinates ...

atomes also provides an advanced input preparation system for further calculations
using well known molecular dynamics codes:

• Classical MD : DL-POLY [1] and LAMMPS [2]

• ab-initio MD : CPMD [3] and CP2K [4]

• QM-MM MD : CPMD [3] and CP2K [4]

To prepare the input files for these calculations is likely to be the key, and most com-
plicated step towards MD simulations. atomes offers a user-friendly assistant to help
and guide the user step by step to achieve this crucial step.
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Chapter 1. Introduction 2

Figure 1.1 Overview of the atomes program.
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Programming framework

atomes is developed in C, GLSL (OpenGL shading language), and FORTRAN90. The
GTK [5] library is used to create the Graphical User Interface, and the OpenMP [6] API
for parallel programming is used to take advantage of the CPU’s cores.
The 3D rendering is performed, via the GtkGLArea widget, using modern OpenGL
language [7], and the Epoxy library is used to ensure the OpenGL function pointer
management. Also the FFmpeg [8] library is used to encode video from off-screen
OpenGL rendering.

2.1 Supported platforms

The GTK library is a highly portable programming interface which allows atomes to
be a cross-platform software. Linux, MacOS (Sonoma 14.4.1 - M3 Max processor) and
Microsoft Windows (10, 11) versions of the program are available.

2.2 Dependencies and requirements

Library Version
Min. required Recommended

GTK+ 3.16 / 4.60 3.22 + / 4.60 +
FFmpeg 3.1 3.41 +
Epoxy 1.3 1.43 +
OpenMP 4.5 4.5 +

Table 2.1 Libraries used by atomes.
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Features

3.1 Main window

a) b) c) d)

Figure 3.1 Main window of the atomes program.

The main interface of the atomes program [Fig. 3.1-a] gives access to:
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• The "Workspace menu" [Fig. 3.1-b] to open and save files, including atomes
workspace and project files.

• The "Edit menu" [Fig. 3.1-c] to adjust chemical / physical of a system to be stud-
ied/edited.

• The "Compute menu" [Fig. 3.1-d] to run some analysis on the active project (see
section 3.5 for details).

• The "Help menu" [Fig. 3.1-e] to access the documentation, a periodic table and
define user preferences (see section 3.9 for details).

atomes allows to build, edit, study, analyse and compare multiple systems within
the same instance of the program. Each system (molecule(s)/material ...) is defined
in a data structure called project, atomes projects (*.apf files) can be opened/saved
separately, the list of opened project(s) appears in the left side of the main window in
a browsable tree-like structure. The entire list of project(s) displayed in this part of the
main window is a data structure called workspace, and atomes workspace files (*.awf
files) can also be opened and saved, allowing to back up the entire list of projects at
once, preserving the possible connections, data exchanges, between each projects.
An illustration is presented in figure 1.1, many different projects being opened in the
workspace. To each of these project is assigned an OpenGL 3D window, few of them
being visible in figure 1.1. Double-clicking on the "Workspace" word at the top root of
the tree, the list of all projects appears in the right side window. This list includes, in
bold green font, the name of the active project (see section 3.5 for details).

Keyboard shortcuts

• Workspace:

Ctrl + w : open workspace

Ctrl + s : save workspace as

Ctrl + c : close workspace

• Project:

Ctrl + n : create new project

Ctrl + o : open project

• Misc:

Ctrl + t : show curve toolboxes

Ctrl + p : open periodic table

Ctrl + a : show about dialog

Ctrl + q : quit

• On any file dialog:

Ctrl + l : open command line

6



7 3.2. Workspace and project tree

3.2 Workspace and project tree

In atomes each project, as soon as it is created and whether it is new (empty) or contains
atomic coordinates, is immediately:

• inserted into the workspace tree: a branch will appear bearing the project name
[Fig. 3.2].

• assigned an OpenGL window for visualization, analysis and edition.

• the "Toolboxes" dialog [Fig. 4.2] is refreshed, and if required open, to present the
data of this project.

Figure 3.2 illustrates the structure of project tree branch in the atomes workspace.

=⇒ =⇒

Figure 3.2 Project tree in the atomes program.

On each line/tree branch in the workspace tree the double-click with the left button of
the mouse has an effect:

• "Workspace" line: displays workspace information, lists all opened project(s) and
gives the name of the active project in bold green font [Fig. 1.1].

• "Project’s name" line: activates the project (see section 3.5 for details), when the
project is active its name is displayed in bold font.

• "Settings" line: provides general information about the project.

• "Visualization" line: open/close the OpenGL visualization window, and display
OpenGL/hardware information.

• Each of the calculation lines (ex: "g(r)/G(r)"): if the calculation was performed
for that project displays summary of the calculation, used parameters, and results.

7
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As illustrated in figure 3.3 the right click of the mouse display a menu basically
reproduces the Workspace menu [Fig. 3.1-b], but also introduces two new buttons to
activate the project (see section 3.5 for details) and edit its name.

Figure 3.3 Mouse left click menu in the workspace tree of the atomes program.

The name of the project supports Pango markup[9]:

• <sub> </sub> for underscore • <i> </i> for italic • <u> </u> for underline

• <sup> </sup> for exponent • <b> </b> for bold • <tt> </tt> for monospace

and more ... see: https://docs.gtk.org/Pango/pango_markup.html

3.3 Files

3.3.1 Importing atomic coordinates

The list of the supported format of atomic coordinates is presented in appendix A.
ISAACS files contains all the information required to prepare analysis and visualization.
For the other file formats, and after reading the atomic coordinates, dialog boxes appears
automatically in the following order:

8
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9 3.3. Files

1) The "Chemistry and physics" dialog [Fig. 3.4]

Figure 3.4 The "Chemistry and physics" dialog in the atomes program.

This dialog allows to tweak the chemical and physical properties of the elements
found in the coordinates file (see figure 3.4).
Particular attention should be given to the selection of the neutrons and X-rays scat-
tering length, for the former parameters are included in atomes (see chapter F), for the
latter two possibilities are offered to the user:

• Use the exact Q dependent method to compute X-rays S(Q) related properties.

• Use an approximation with the X-rays scattering length equal to the atomic num-
ber of the element.

2) The "Box and periodicity" dialog [Fig. 3.5]

Figure 3.5 The "Box and periodicity" dialog in the atomes program.

This dialog allows to define the periodicity and if needed adjust the model box
proportions, or lattice vectors (see [Fig. 3.5]).

9
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3) The "Bond cutoffs" dialog [Fig. 3.6]

Figure 3.6 The "Bond cutoffs" dialog in the atomes program.

This dialog allows to adjust the cutoff distances used to define the existence or
absence of chemical bonds (see figure 3.6), both for the calculations (see section 3.5)
sensitive to these parameters and for the 3D visualization in the OpenGL window (see
section 3.6).
As soon as the "Bond cutoffs" dialog closes atomes will have everything required to
setup the 3D model and the OpenGL window will appear.

The 3 dialog boxes "Chemistry and physics", "Box and periodicity" and "Bond
cutoffs" can be re-opened again later on using the "Edit" menu [Fig. 3.1-c]. However
in that case only the active project parameters can to be modified. Therefore remember
to activate the project you want to edit before using the edit menu.

10



11 3.3. Files

3.3.2 Reading atomes project file(s)

The atomes project file allows to store:

• The atomic coordinates, including MD trajectories.

• The results/data of all calculations performed within atomes.

• The results of all modifications of the calculations data, including graph windows
(see chapter 4).

• The parameters of the OpenGL window, so that when re-opened the project
appears exactly as it was when saved.

The main idea being to be able to resume work exactly where it was before saving the
atomes project file.

The atomes project files have the extension: .apf

To open atomes project file(s) use the "Open Project File(s)" dialog [Fig. 3.7].
This can be done using alternatively:

• The workspace menu.

• The right click menu obtained with the mouse button of the workspace tree.

• The keyboard shortcut Ctrl + o on top of the atomes program main window.

Many atomes project files can be opened simultaneously, simply select all projects to
be opened in the "Open Project File(s)" dialog, click "Open" and they will appear in
the workspace tree:

=⇒

Figure 3.7 The "Open Project File(s)" dialog in the atomes program.

Later on when using the atomes program remember that any window specifically
dedicated to a project will have the name of this project in its title bar.
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3.3.3 Reading atomes workspace file(s)

The atomes workspace file allows to store:

• A collection of atomes projects.

• The relations between these projects, data exchanges, comparisons ...

Again the idea is to be able to resume work exactly where it was before saving the
atomes workspace file.

The atomes workspace files have the extension: .awf

To open atomes workspace file use the "Open Workspace" dialog [Fig. 3.8].
This can be done using alternatively:

• The workspace menu.

• The right click menu obtained with the mouse button of the workspace tree.

• The keyboard shortcut Ctrl + w on top of the atomes program main window.

Only a single atomes workspace file can be opened at a time, if needed close the opened
workspace, then open the new one:

=⇒

Figure 3.8 The "Open Workspace" dialog in the atomes program.
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3.4 User preferences

The "User preferences" dialog that can be opened via the "Help" menu of the main
window allows to adjust atomes internal options for all projects to be opened in atomes
workspace, configuration options include:

• Analysis option

• OpenGL rendering options

• Model atom(s), bond(s), label(s) and model box options

• Representation, projection, background, axis and selection options

As illustrated in the next pages it is possible to configure the default behavior of several
parts of the software.

Figure 3.9 The "User preferences" dialog in the atomes program.

When clicking on "Apply", and after confirmation, the options defined in the "User
preferences" dialog are applied to the active session of atomes. Afterwards options
can be stored in a XML file named "atomes.pml" (which exact location depends on
your operating system), if found this file will be process at every atomes startup to
ensure for user selected options to be used. Optionaly if projects are opened in atomes
workspace it is possible to apply selected options to any of these projects.
Note that you can restore atomes default internal parameters at any time from the
"General" tab.

13



Features 14

3.4.1 Analysis options

Figure 3.10 The "Analysis preferences" dialog in the atomes program.

Analysis options tabs 3.10 cover physico-chemical analysis parameters required to
perform the corresponding calculations. The "General" page offers to specify how first
neighbor atoms are determined in the atomes software.

3.4.2 OpenGL rendering options

Figure 3.11 The "OpenGL preferences" dialog in the atomes program.

Rendering can be entirely configured using this tab, including style and colormpas,
material aspect, lights and fog options that can be adjusted to user preferences.

14
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3.4.3 Model options

Figure 3.12 The "Model preferences" dialog in the atomes program.

This tab allows to configure model style from atomic species color to atom and bond
radii for any rendering style available in the atomes software. Atom and clone labels
as well as model box layout can also be configured.

3.4.4 Representation options

Figure 3.13 The "View preferences" dialog in the atomes program.

This tab offers configuration options to defined default background, representation,
axis layout and measurement information layout.
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3.5 Analyzing models using atomes

atomes can compute the following structural characteristics of a 3D structure model:

• Radial distribution functions g(r) (RDFs) [10] including ◦:

– Total RDFs for neutrons and X-rays.

– Partial RDFs.

– Bhatia-Thornton RDFs [11]

◦ Radial distribution functions can be computed by i) direct real space calculation and/or
ii) Fourier transforming of the structure factor calculated using the Debye formalism [12]

• Structure factors S(q) [12] including ◦◦:

– Total structure factors S(q) for neutrons and X-rays.

– Total Q(q) [12, 13] for neutrons and X-rays.

– Partial S(q):

* Faber-Ziman [14] partial S(q)

* Ashcroft-Langreth [15, 16, 17] partial S(q)

* Bhatia-Thornton [18] partial S(q)

◦◦ Structure factors can be computed by i) Fourier transforming of the radial distribution
functions and/or ii) using the Debye formalism [12]

• Interatomic bond properties

– Coordination numbers

– Atomic near neighbor distribution

– Fraction of links between tetrahedra

– Fraction of tetrahedral units

– Bond lengths distribution for the first coordination sphere

• Distribution of Bond angles

• Distribution of Dihedral angles

• Ring statistics, according to several definitions:

– All closed paths (no rules)

– King’s rings [19, 20]

– Guttman’s rings [21]

– Primitive rings [22, 23] (or Irreducible [24])

– Strong rings [22, 23]

And including options to:

– search only for ABAB rings

– exclude rings with homopolar bonds (A-A or B-B) from the analysis

16



17 3.5. Analyzing models using atomes

Ring statistics is presented according to the R.I.N.G.S. method [25].

• Chain statistics, including options to:

– search only for AAAA chains

– search only for ABAB chains

– exclude chains with homopolar bonds (A-A or B-B) from the analysis

– search only for 1-(2)n-1 chains

• Spherical harmonics invariant, Ql, as local atomic ordering symmetry identifiers [26]

– Average Ql for each chemical species

– Average Ql for a user specified structural unit

• Mean Square Displacement of atoms (MSD)

– Atomic species MSD

– Directional MSD (x, y, z, xy, xz, yz)

– Drift of the center of mass

See appendix E to learn more about the physics and the chemistry behind these
calculations.

The calculations presented in this list can only be performed on the active project, ie.
the project which name appears in the title bar of the atomes program main window,
in bold font in the atomes workspace tree and in green bold font in the workspace
information dialog [Fig. 1.1].
For more about running calculation using atomes see chapter 4.
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3.6 Visual analysis using atomes

Each model in the atomes workspace is assigned an OpenGL window that provides an
interactive experience to visualize and analyze its properties. Isolated configurations
as well as entire molecular dynamics trajectories can be visualized.
Among the possibilities of the OpenGL window:

• Advanced color map options, for both atoms and polyhedra.

• Advanced coordination(s) visualization options (total, partial, fragments,
molecules).

• Advanced coordination polyhedra visualization options.

• Measurement tools.

• Advanced layout system for atomic labels, measurements, MD box and model
axis.

• Image and movie rendering, including an intuitive interface to movie encoding
that allows to record every interaction/modification made to the OpenGL window.

• Advanced OpenGL configuration options.

For a complete description of these features see chapter 5.

3.7 Visual edition and model creation using atomes

Using atomes "Crystal builder" it is possible to build crystalline structures or even
super-structures. Also if the model description contains a box, then cell edition options
become available:

• Wrap atoms in original cell

• Shift cell center

• Add extra cell(s)

• Create super cell

• Change the model density

• Cut slabs or extract atoms from the model.

And if the model contains only a single configuration (and not a molecular dynamics
trajectory), or when an empty project is created, the atom(s) edition options/mode
become available:

• Motion (random or selected atom(s))

• Replacement (random or selected atom(s))

• Removal (random or selected atom(s))

• Insertion

For a complete description of these features see chapter 6.
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3.8 Preparing MD calculations in atomes

atomes provides input creation assistants for well known molecular dynamics codes:

• CPMD [3]

• CP2K [4]

• DL-POLY [1]

• LAMMPS [2]

For a complete description of these features see chapter 7.
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Physico-chemical analysis in atomes

In this chapter examples will be illustrated using an atomes workspace presented in
figure 4.1, this workspace contains 3 different projects, liquid GeSe systems with a
similar chemistry yet obtained using a different set of DFT-GGA functionals. [27]

Figure 4.1 Example workspace to illustrate the analysis capabilities of the atomes pro-
grams containing 3 projects, named "l-GeSe [BLYP]", "l-GeSe [PBE]" and
"l-GeSe [PW91]".

When a project is opened in the atomes workspace, and if this project is the active
project, then it it possible to compute the properties presented in section 3.5, and the

21
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parameter(s) of the calculation(s) can be adjusted via the associated dialog boxes acces-
sible by using the "Analyze" menu [Fig. 3.1-d].
Some of the calculations of the "Analyze menu" are immediately available when a
project is opened, other require some condition(s) to be full-filled before being accessi-
ble:

1. g(r)/G(r): requires a model box to be described.

2. S(q) from FFT[g(r)]: requires 1 to be completed.

3. S(q) from Debye equation: requires a model box to be described.

4. g(r)/G(r) from FFT[S(q)]: requires 3 to be completed.

5. Bonds and angles: no conditions.

6. Ring statistics: no conditions.

7. Chain statistics: no conditions.

8. Spherical harmonics: requires 5 to be completed.

9. Mean Squared Displacement: requires the project have more than 1 configuration
(MD trajectory).

4.1 Visualisation of the results of the calculations

When a particular structural characteristic is computed results can be directly displayed
in the main atomes windows [Fig. 3.1-a]. In addition the visualization mode of most
of the computed characteristics can be controlled the "Toolboxes" dialog:

Figure 4.2 The "Toolboxes" dialog in the atomes program.

The "Toolboxes" dialog contains a tree that becomes browsable for a particular calcu-
lation when that calculation is completed successfully.
If closed the "Toolboxes" dialog can be opened alternatively using:

• The last button of the "Analyze menu" called "Toolboxes" [Fig. 3.1-d].
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23 4.1. Visualisation of the results of the calculations

=⇒ =⇒

w

Figure 4.3 Interaction with the "Toolboxes" dialog in the atomes program.

• The Ctrl + t keyboard shortcut over the main window of the atomes program.

When a button in an interaction menu is activated [Fig. 4.3] the corresponding result
is instantaneously displayed as a curve or a histogram [Fig. 4.3] depending on the
nature of the computed structural characteristic, in figure 4.2 the g(r) for the project
"l-GeSe [PW91]" for the example workspace in figure 4.1.
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4.2 Data and plot edition

atomes offers editing tools which allows to edit/save/export the data from the calcula-
tions, and configure the layout of the graphs showing result of the calculations. These
tools are available from both the contextual menu [Fig. 4.8] and the top menu of any
graph window [Fig. 4.3].

4.2.1 Data edition

As illustrated in figure 4.4 it is possible to edit any of the data set presented in the graph
window in a spreadsheet like environment (including a contextual menu accessible
using the right button of the mouse).

w

Figure 4.4 Top: The "Data" and the "Edit Data" menus in the top menu of the graph
window. Bottom: the "Data Edition" window and the associated contextual
menu.
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25 4.2. Data and plot edition

4.2.2 Plot edition

Figure 4.5 The "Curve" menu, and the corresponding buttons in the contextual menu of the
graph window in the atomes program.

Using the data plot editing tool [Fig. 4.6] it is possible to configure the layout of the
selected graph, as well as the layout each data set which happen to be plotted on the
graph, it is also possible to configure X and Y axis layout and/or position.

Figure 4.6 The data plot editing tool box in the atomes program.
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Furthermore depending on the calculation several data sets can be selected and plotted
together with the main data set of the active window. Data plot edition in the atomes
program is illustrated with the example in figure 4.7.

Figure 4.7 Examples of data plot edition in the atomes program.
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4.3 Mouse interaction with the data plot

4.3.1 Right button contextual menu

To use the right button of the mouse over the graph window allows to open a contextual
menu [Fig. 4.8].

Figure 4.8 Mouse contextual menu over the graph window in the atomes program.

This menu allows the following actions:

1. Edit Data : essentially reproduces the "Edit data" submenu from the graph
window’s top menu [Fig. 4.9-a].

2. Save Data (see section 4.2)

3. Edit Curve (see section 4.2)

4. Export Image (see section 4.2)

5. Add Data Set: allows to add data set(s) to the graph window, this extra data
set from a similar kind of calculation can come either from the same project or
any other project opened in the workspace. The submenu list of available data
set(s) compatible with the present graph/calculation in the workspace and offers
shortcuts to insert each of them in the graph [Fig. 4.9-b].

6. Remove Data Set: allows to remove data set(s) from the graph window. Only data
sets that were actually added to the graph window can be removed and not the
initial data set of the graph window (in this example case the "g(r) neutrons"
for "l-GeSe [PW91]" project [Fig 4.9-c].

7. Autoscale: offers to autoscale the x and y axis for the entire set(s) of data presented
in the graph window.

8. Close: closes the graph window.
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a)

b)

c)

Figure 4.9 The "Edit Data" a), "Add Data Set" b) and "Remove Data Set" c) sub-
menus in the graph window contextual menu for the example workspace [Fig. 4.1].
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29 4.3. Mouse interaction with the data plot

4.3.2 Left button zoom in and out

Using the mouse over the graph window it is possible to zoom in and out, by pressing
the left button and then and move up/down/left/right while keeping the button pressed.
Then a rectangle will be drawn over the window [Fig. 4.10], starting at the point where
the button was first pressed, and ending at the point the mouse is hanging over. The
effect of the zoom action will be specified by a text inscription at the origin point of the
rectangle, and by the color of the rectangle:

• Zoom in(x) and in(y): direction from bottom left to top right, and red color.

• Zoom in(x) and out(y): direction from top left to bottom right, and violet color.

• Zoom out(x) and in(y): direction from bottom right to top left, and blue color.

• Zoom out(x) and out(y): direction from top right to bottom left, and green color.
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=⇒

=⇒

=⇒

=⇒

Figure 4.10 The mouse left button zoom in/out of the graph window in the atomes program.
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4.4 Saving the data

Results computed by atomes can be easily saved using the standard copy and paste
method (for the results presented in the edition window [Fig. 4.4] or in the main atomes
window [Fig. 3.1]) or using the "Data menu" [Fig. 4.4]. It is possible to export data either
in a raw ASCII format (simple two columns file with x and y) or in the Xmgrace format
which can be used immediately in the Grace WYSIWYG 2D plotting tool [28] for further
analysis.
Note that if more than one data sets are presented on the same graph window, then all
data sets will be written in the same file when saving the data. Thus, for a particular
calculation, if all data sets are added to the graph window using the data plot editing
tool [Fig. 4.6], then all the data result of this analysis can be saved at once. This is true
for both ASCII and Xmgrace file formats.

4.5 Keyboard shortcuts

• Combined keys shortcuts:

Ctrl + a : Autoscale

Ctrl + c : Close curve window

Ctrl + e : Open the data plot editing tool box [Fig. 4.6]

Ctrl + i : Export image

Ctrl + s : Save / export data

31





Visual analysis in atomes

In this chapter examples will be illustrated using an atomes workspace presented in
figure 5.1, this workspace contains 3 different projects:

• a molecular surface of Nickel-Phthalocyanine molecules with 512 atoms.

• a SiO2 glass with 3000 atoms.

• a GeS2 glass molecular dynamics trajectory with 500 MD steps and 258 atoms.

Figure 5.1 Example workspace to illustrate the visualization capabilities of the atomes pro-
gram containing 3 projects, named "Ni-Phth", "g-SiO2" and "l-GeS2".
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5.1 Window top bar menu

In order to present the functionalities available in the OpenGL window, we will browse
the top bar menu [Fig. 5.1] and present each submenu one after the other.

5.1.1 The "OpenGL" menu

a)

b)

c)

d)

Figure 5.2 The "OpenGL" menu and the attached submenus.

The "OpenGL" menu is detailed in figure 5.2. The behavior of the "Render" menu
[Fig. 5.2-c], and the "Quality" menu [Fig. 5.2-d], as well as of the "Render image" button
being pretty intuitive the following only detail the behavior of the "Style menu", the
"Color scheme(s)" menu [Fig. 5.2-b], and the "Material and lights" button.
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35 5.1. Window top bar menu

5.1.1.1 The "Style" menu

Using the "Style" menu it is possible to define to default style of the model represen-
tation, the options are among the most commonly used in chemistry. Changing the
default style from this menu will update several parts of the OpenGL window and
associated menus. For instance selecting the "Ball and stick" option will update the
first tab of "Atom(s) configuration" dialog [Fig. 5.6] to display atomic radius and the
"Bond(s)" menu [Fig. 5.5] to present the "Radius(ii)" and offer a shortcut to modify
their values.
It is possible to define local style(s) to improve the visual representation, however this
is only possible using the mouse, see section 5.2.2.1, and changing the default style
of the model using the "Style" menu will reset/erase any local style(s) value(s) to the
default.

5.1.1.2 The "Color scheme(s)" menu

In the atomes program when the file is opened most of the bonding properties are
calculated "on-the-fly", allowing to gain insights on the atomic coordinations, as well
as the number of fragments and the different molecules in the model.
Therefore before using the "Color scheme(s)" menu it is important to be familiar with
the following definitions:

• Total coordination = total number of first neighbor atoms around the atom.

• Partial coordination = number of atoms of each chemical species around the
atom.

• Fragments = isolated molecular objects in the model.

• Molecules = the different topological objects in the model.

• Coordination polyhedra = structure drawn by linking the atoms of the first
coordination sphere for a particular atom. Requires the considered atom to have
3 neighbors, then the atom it-self is used as a point to build the polyhedra, or
more.

The "Color scheme(s)" menu allows to change the Color Map (CM) for both atoms
and coordination polyhedra, based on the bonding analysis performed using the bond
cutoff(s) specified by the user. An illustration is provided in figure 5.3 for the "Ni-Phth"
project of the example workspace, note that is this model the molecule on the top is
missing a hydrogen atom compared to the one that composed the surface.
The colors of each objects can be modified/adapted via the appropriate menus/dialogs
(see sections 5.1.2 and 5.1.3).
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a) b)

c) d)

Figure 5.3 The standard Colors Maps (CM) for the atoms accessible using the "Color
scheme(s)" menu. Top standard colors using the chemical species, a) Total
coordinations as CM, b) Partial coordinations as CM, c) Fragments as CM and
d) Molecules as CM.
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Using a custom color map

Alternatively to the CMs proposed by the atomes program it is possible to apply a user
defined CM to the OpenGL model, this option is accessible via the "Custom" button of
the "Atoms & bonds" menu [Fig. 5.2-b]. In that case it is required to read a file (having
the extension "*.dat") that contains the numerical data to be used as color scale. This
file must be a simple (Unix like) text file with as many lines as:

Total number of MD steps × Total number of atoms

Indeed the new colors can be applied to the entire MD trajectory.
An example is provided hereafter for the silica glass model:

1. In the initial setup the chemical species are used as color map:

2. When the "Custom" button is pressed for the atoms CMs, the "Custom color map
setup" dialog appears:
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3. (a) The "Import / Save data" button allows to import your data file to create the
color map. If the data file is processed successfully then atomes will propose to
use it and a confirmation dialog will pop-up:

For this example the data points are simply the atom indices from 1 to 3000.

4. (b) Afterwards using the "Edit data" button it becomes possible to edit the data
in a basic spreadsheet like mode, so that values for a particular atom can be
checked and/or modify if needed:

5. (c) And using the "Customize color map" button is possible to customize the
color map, initially a gradient of red an blue between the maxima and the minima
of the values in the data set is used, but you can easily add or remove point(s),
and adjust the corresponding color to enhance the visual representation of your
model:
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=⇒

6. Finally simply apply the changes to use the new colors:

7. The "Custom" data and the corresponding color map are saved within the atomes
project and workspace files (see sections 3.3.2 and 3.3.3), so that it will not be
require to load a prepare the color map between work sessions.
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5.1.1.3 Material and lights

The "Material and lights" button of the "OpenGL" menu opens the "OpenGL material
aspect and light settings" dialog [Fig. 5.4]:

Figure 5.4 The "OpenGL material aspect and light settings" dialog in the
atomes program.

The window contains a notebook with 3 tabs:

• The first tab allows to configure/adjust:

– The quality of the rendering, ie. the number of polygons to render a volume.

– The lightning model, from the lowest quality (fastest to render, "None") to
the highest quality (longer to render, "Cook-Torrance-GCX").

– The material aspect, few templates being available, but all characteristics
required to describe the material aspect for the light mode being available.

• The second tab allows to configure the lights sources of the model:

– 3 type of light source being available: directional, point and spot lights.

– With the possibility to add up to 10 light sources.

• Finally the third tab is used to adjust the fog effects

For information on OpenGL lightning models, material effects, lights, and more see:

• https://learnopengl.com/Lighting/Basic-Lighting

• https://learnopengl.com/Advanced-Lighting/Advanced-Lighting
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5.1.2 The "Model" menu

a)

b)

c)

d)

Figure 5.5 The "Model" menu and the attached submenus.
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5.1.2.1 The "Atom(s)" menu

The "Atom(s)" menu [Fig. 5.5-a] offers to configure some visual features related to the
chemical species in the model. This menu contains shortcuts for some the properties
that can be adjusted using the more advanced "Atom(s) configuration" dialog, and
that can be opened using any of the "Advanced" buttons in the menu. The "Atom(s)
configuration" dialog is presented in figure 5.6:

Figure 5.6 The "Atom(s) configuration" dialog in the atomes program.

The window contains a notebook with 3 tabs:

• (a) The "Display properties" tab: to adjust chemical species colors, atomic
labels, and depending on the model style:

– Ball and sticks: atomic radius

– Wireframe or Points: point size

• (b) The "Label properties" tab: to adjust the aspect of the atomic labels.

• (c) or (d) The "Atom(s) selection": to search for atom(s) in the model. If the
model contains less than 10 000 atoms the entire list of atoms is displayed (c),
otherwise it becomes too complicated to display and a search engine is proposed
(d).
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5.1.2.2 The "Bond(s)" menu

Via the "Bond(s)" menu [Fig. 5.5-b] it is possible to adjust the bond cutoff(s), and
depending on the model style:

• Ball and sticks: bonds radius(ii)

• Cylinders: bond radius

• Wireframe: line width

5.1.2.3 The "Clone(s)" menu

The atomes program uses clones to illustrate the presence of atomic bond(s) on the
edges of the simulation box and existing because of the periodic boundary conditions
(see section E.1 for more information on the PBC).
For the "Clone(s)" menu to be activated two conditions must be fulfilled: to use PBC,
ie. the model must have a periodicity, and, for such bonds via PBC to exist. If both
conditions are met, then the first button of the menu to "Show/Hide Clones" will be
active and it becomes possible to show or hide the clones.
Please note that clone atoms/bonds are translucent to make them easily distinguishable
from their atom/bond counterparts, figure 5.7 illustrates the clones idea using the silica
glass model:

a) b)

Figure 5.7 The concept of clones in the atomes program. a) Standard representation using
cylinders, b) Clones are included in the representation.

If the clones are visible then the two "Atom(s)" and "Bond(s)" submenus will be ac-
tivated as well. These menus are reproductions of the upper level "Atom(s)" and
"Bond(s)" menus, and windows, but dedicated to the clones, this allows to make the
clones even more distinguishable in the 3D representation.
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5.1.3 The "Chemistry" menu

a)

b)

c)

d)

e)

Figure 5.8 The "Chemistry" menu and the attached submenus.
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The "Chemistry" menu [Fig. 5.8] and all the attached submenus from a) to e) are
essentially composed of shortcut buttons to the options/actions that can be performed
using the "Environments configuration" window, this section will therefore focus on
the presentation of this window.

The "Environments configuration" window

The "Environments configuration" window contains a notebook with several tabs.
The number of tabs depends on the calculations that were performed to analyze the
model, ring statistics and chain statistics calculations will insert new tabs in the note-
book. The different tabs of "Environments configuration" window are:

1. The "Parameters" tab (see 1)

2. The "Total coordination(s) [TC]" tab (see 2)

3. The "Partial coordination(s) [PC]" tab (see 2)

4. The "Polyhedra from TC" tab (see 3)

5. The "Polyhedra from PC" tab (see 3)

6. The "Fragment(s)" tab (see 4)

7. The "Molecule(s)" tab (see 4)

8. The "? ring(s) [?R]" tab (see 5 and 6)
The "Polyhedra from [?R]" tab
The "Isolated ring(s) from [?R]" tab

9. The "Chain(s)" tab (see 7)
The "Isolated chain(s)" tab

Tabs 1, 2, 3, 4 and 5 are always present in the notebook, tabs 6 and 7 are present
providing that the fragment(s) and the molecule(s) analysis were performed. Tabs 8
are inserted in the notebook when any of the ring statistics analysis are completed,
whereas the tabs 9 are inserted when the chain statistics analysis is completed. Overall
the "Environments configuration" window can contain up to 24 tabs.
Each tab in [1-9] is presented in detail thereafter:
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1. The "Parameters" tab

This tab reproduce this available color map options from the "Color scheme(s)"
menu (see section 5.1.1.2). Many of the following tabs allow to adjust the color
of the element(s) for each color map, only for the change to be visible the corre-
sponding color map must be used.
The "Parameters" tab also contains a "Cloned polyhedra" button, that allows to
display polyhedra on the edges of the simulation box, and this even if clones are
not shown.
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2. The "Total coordination(s) [TC]" and "Polyhedra form TC" tabs

a) b)

a) The "Total coordination(s) [TC]" tab presents a list of options related to
the total coordination sphere(s) found during the bonding analysis:

• A "Color" button: to adjust the color of the each element. Initially a color
being assigned to each number of neighbors independently of the chemical
species involved.

• A "Show" button: to hide/show the atom(s) matching the associated property.

• A "Label" button: to hide/show the atomic label of the atom(s) matching the
associated property.

• A "Pick" button: to select/unselect the atom(s) matching the associated prop-
erty (for more information on atom selection see section 5.2) .

In the "Ni-Phth" project example, the colors in a allow to obtain the representation
from [Fig. 5.3-a].
b) The "Polyhedra form TC" tab presents a list of options related to the total
coordination sphere(s) with 3 or more neighbors:

• An "Alpha" range: to adjust the opacity of the coordination polyhedra for
the atom(s) matching the associated property.

• A "Show" button: to hide/show the coordination polyhedra for the atom(s)
matching the associated property.
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3. The "Partial coordination(s) [PC]" and "Polyhedra form PC" tabs

c) d)

The "Partial coordination(s) [PC]" c) and the "Polyhedra form PC" d) tabs
are similar to a) and b) respectively, coordination spheres being also separated
based on the analysis of the chemistry of the bond(s). In the "Ni-Phth" project
example, the colors in c) allow to obtain the representation from [Fig. 5.3-b].

4. The "Fragment(s)" and "Molecule(s)" tabs

e) f)

The "Fragment(s)" e) and "Molecule(s)" f) tabs follow similar ideas than a) (or
c)) but for the fragment(s) and molecule(s) respectively. In these examples from
the "Ni-Phth" project, the colors in e) and f) allow to obtain respectively the
representations from [Fig. 5.3-c] and [Fig. 5.3-d].
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5. The "? ring(s) [?R]", "Polyhedra from [?R]" tabs

g) h)

Whenever a ring statistics calculation is performed successfully and ring(s) is/are
found in the model, the "? ring(s) [?R]" g) and "Polyhedra from [?R]" h)
tabs are inserted in the "Environments configuration" window, g) and h) are
examples from the g-SiO2 model for which King’s rings analysis was performed.
If other analyses were performed more tabs would be inserted following a similar
idea, and ? is the name of the methodology to search for rings, among: All
(No rules), King’s, Guttman’s, Primitive and Strong (see section E.5 for more
information on ring statistics).
The "? ring(s) [?R]" tab presents a list of options related results of the ring
statistics calculation, for each size of ring:

• A "Color" button: to adjust the color of the each element. Note that this color
only concerns the polyhedra. Initially a different color is assigned to each
size of ring(s).

• A "Show" button: to hide/show the atom(s) involved in ring(s) of that size.

• A "Label" button: to hide/show the atom(s) involved in ring(s) of that size.

• A "Pick" button: to select/unselect the atom(s) involved in ring(s) of that
size.

The "Polyhedra from [?R]" tab present other options related results of the ring
statistics calculation, for each size of ring:

• An "Alpha" range: to adjust the opacity of the polyhedra drawn using the
atom(s) of each ring of that size as summits.

• A "Show" button: to hide/show the polyhedra drawn using the atom(s) of
each ring of that size as summit.
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6. The "Isolated ring(s) from [?R]" tab
i) j)

In the "Isolated ring(s) from [?R]" tab every single ring found can be look-up
individually. Most often i) version of the tab is used, however if more than 10 000
rings are found it becomes too complicated to display the entire list and a search
engine is proposed instead j).
Among the options provided by the "Isolated ring(s) from [?R]" tab:

• A "Show" button: to hide/show the atom(s) involved in this ring.

• A "Ploy" button: to hide/show the polyhedra drawn using the atom(s) of
this ring as summits.

• A "Label" button: to hide/show the atom(s) involved in this ring.

• A "Pick" button: to select/unselect the atom(s) involved in this ring.

7. The "Chain(s)" "Isolated chain(s)" tabs

These tabs (not shown) are dedicated to the results of the chain statistics analysis,
and simply reproduces options of tabs g) and i)/j), at the exception that there are
no polyhedra to display.
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5.1.4 The "Tools" menu

a)

b)

c)

d)

e)

Figure 5.9 The "Tools" menu and the attached submenus in the atomes program.

The "Edit" menu a), that regroups the edition tools will be covered in chapter 3.7,
and the "Molecular Dynamics" menu d), regrouping the MD input assistants will be
covered in chapter 7. Also the actions of the "Invert" menu e) being pretty intuitive, this
section will only present the "Measures" button/dialog, the "Mouse mode" b), "Selection
mode" c) menus.
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The "Measures" dialog

Pressing the "Measures" button will open the "Measures" dialog [Fig. 5.10], that contains
a notebook with 3 tabs, for inter-atomic distances, angles and dihedrals, and a button
labelled "Font and style" to configure how the measure(s) will appear on the model.

Figure 5.10 The "Measures" dialog in the atomes program, with the "Distances",
"Angles" and "Dihedrals" tabs.

Each tab contains the respective measured properties for all the atoms in selection (see
section 5.2 for more information on the selection process), this means the atoms that
have been selected before opening the dialog, or, while it is opened and the tabs will
refresh. The tabs read as follow:

• First (2/3/4) columns the atoms id’s

• Column (3/4/5): the value measured in the model

• Column (4/5/9): If PBC are used/required to measure the value (to avoid visual
deception)
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Behavior of the "Measures" dialog:

1. If too many atoms are in selection then the tabs will remain empty and the
measures will not show up. To get the information about the measures back
simply decrease the number of atoms selected under 20 atoms for the distances
and the angles, and under 10 for the dihedrals.

2. If any line is selected by a mouse click in the tabs, then the font color of this line
will change and the corresponding measure will appear in the model with the
same color. In figure 5.10, 2 lines are selected in the "Distances" tab, and 1 line is
selected in the "Angles" tab, the result is presented in figure 5.11.

Figure 5.11 Some examples of measurements displayed in the OpenGL window.

3. No visual information is available for the dihedral angles and only the numerical
values are provided.
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The "Volumes" dialog

Pressing the "Volumes" button will open the "Volumes" dialog [Fig. 5.12], that contains a
notebook with 3 tabs, for overall atomic volumes ("Model"), isolated fragment volumes
("Fragment(s)"), molecular volume ("Molecule(s)").

Figure 5.12 The "Volumes" dialog in the atomes program, with the "Model",
"Fragment(s)" and "Molecule(s)" tabs.

Tabs are divided in two parts: top for molecular volume(s) calculated for the respective
target, bottom for calculations to dermine the smallest rectangle parallepiped volume
for the respective target. Also volumes can be evalutated for different types of atomic
radii (covalent, ionic, van Der Waals and in crystal), and on the first tab ("Volumes"),
the angular precision (rotation of the volume) can be fine tuned for all calculations.
Once a "Compute" button is pressed the selected calculation will be perfomed, then
numerical results become available and can be visualized pressing the corresponding
"Show/Hide" button:

Figure 5.13 Volumes visualization in the atomes program: smallest rectangle parallepiped
volumes found for each of the isolated fragment in molecule 1.
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The "Mouse mode" menu

This menu allows to switch the mouse mode between "Analysis" (default) and
"Edition". This menu is active, only and only if, there is a single configuration in
the project (and not a molecular dynamics trajectory). Therefore when studying a MD
trajectory only the "Analysis" mode is available.

The "Selection mode" menu

This menu allows to adjust the mouse selection capabilities, and switch between:

1. Atom/bond (default): selection atom by atom or bond by bond.

2. Coordination sphere: the atom and all its first neighbors.

3. Fragment: the atom and all other atom(s) that belong to the same fragment.

4. Molecule: the atom and all other atom(s) that belong to the same molecule.

5. Single fragment: same as 3 and unselect all other atoms in the model.

6. Single molecule: same as 4 and unselect all other atoms in the model.

7. Measures (Edition mode only): will be covered in chapter 6.

55



Visual analysis in atomes 56

5.1.5 The "View" menu

a)

b)

c)

d)

Figure 5.14 The "View" menu and the attached submenus in the atomes program.

Being very intuitive the actions of the "View" menu will not be discussed in this
manual.
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5.1.6 The "Animate" menu

Figure 5.15 The "Animates" menu of the OpenGL window in the atomes program.

The animate menu allows to open 3 different dialog boxes:

The "Spin" dialog

The "Spin" dialog [Fig. 5.16] allows to spin the model:

Figure 5.16 The "Spin" dialog of the OpenGL window in the atomes program.

When one of the arrow (left, right, up, down) button is pressed the model will start
rotating in that direction. It is possible to combine directions by pressing several
buttons, also the rotation speed is determined by the number of times the button was
pressed: the more it was pressed the faster the model will rotate. To decrease the
rotation speed, press the arrow button(s) in the opposite direction(s) to the rotation.
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The "Sequencer" dialog

The "Sequencer" dialog [Fig. 5.17] allows to animate and review a molecular dynamics
trajectory, and is therefore only accessible if the project contains more than a single
atomic configuration:

Figure 5.17 The "Sequencer" dialog of the OpenGL window in the atomes program.

The "Recorder" dialog

The "Recorder" dialog [Fig. 5.18] allows to record any action on the OpenGL window:

a) b)

Figure 5.18 The "Recorder" dialog of the OpenGL window in the atomes program.

As soon as the green "Record" button [Fig. 5.18-a] is pressed, and turns to red [Fig. 5.18-
b], any action performed on the OpenGL window will be recorded, (the "Spin" and
the "Sequencer" dialogs for example can be opened and used while recording) and the
recording will continue until the "Stop" button is pressed, then the "Movie encoding"
dialog will pop-up [Fig. 5.19]
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Figure 5.19 The "Movie encoding" dialog of the OpenGL window in the atomes program.

The "Movie encoding" dialog allows to adjust any parameters required to encode a
nice movie.
Many of the video codecs available in atoms [Fig. 5.19] are sensitive to the parameters
that can be entered in this dialog. For instance the MPEG-4 and H264 video codecs seem
to be very sensitive to the utilization of standard video resolutions (800x600, 1980x1024
...). However by default atomes input the dimensions of the OpenGL window as
Movie resolution and the codec might not like non-standard parameters as the values
in figure 5.19, and the encoding could fail.
Depending on the codec this might be true for any of the parameters that can be adjusted
in this dialog. Moreover error messages (from the encoding library) are not necessarily
displayed, and the error might not be seen directly.
However even if the encoding fail atomes will not crash, and as long as the "Cancel"
button of the dialog [Fig. 5.19] is not pressed all data required to encode the movie is
perfectly safe in memory, and there is no problem in retrying to encode with a change
of parameters.
Therefore before closing the "Movie encoding" dialog, action that will delete the data
in memory it is recommended to check the result of the encoding, ie. play the movie,
if the result is good enough then it is safe to close the dialog by pressing "Cancel".
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5.2 Mouse interaction with the OpenGL window: visu-

alization

The mouse button functions are the following:

• Left button

– Single click on object: object selection

– Pressed on background + motion: model rotation

• Scroll button

– Scrolled: zoom in/out

– Pressed + motion: model translation

• Right button

– Pressed on background: reproduces the OpenGL window top bar menu

– Pressed on object: object contextual menu

5.2.1 Object selection

The mouse left button allows to select object(s) and display atomic label(s):

a) b)

=⇒

c)

v w

Figure 5.20 Illustration of the selection / label process using the mouse left button.

The first click on any atom/bond will select this atom/bond, the selection is highlighted
/ covered in light blue color [Fig. 5.20-b], a second click and the atom(s) label(s) will be
added to the representation [Fig. 5.20-c], finally a third click will unselect the atom(s)
and remove the label(s) [Fig. 5.20-a].
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5.2.2 Object contextual menu

Pressed over an atom or a bond the right button opens the object contextual menu:

a) b)

Figure 5.21 The object contextual menu: a) for an atom, b) for a chemical bond.

• Over An atom: the menu in figure 5.21-a) is displayed, the top part provides
several information (when available) related to the atom:

– The atom id: chemical species and id number in the project

– The atom coordinates

– Total coordination of the atom

– Partial coordination of the atom

– Fragment and molecule id the atom belongs to

• Over A chemical bond: the menu in figure 5.21-b) is displayed, the top part provides
several information (when available) related to the bond:

– The atoms involved in the bond

– The bond length

– Fragment and molecule id the bond belongs to
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The bottom parts of the object contextual menus in figure 5.21 are almost identical,
and contain a list of submenus dedicated to several actions that could be performed in
relation to the object, atom or chemical bond, of the contextual menu. The construction
of each submenu follow a similar pattern presented bellow.

Construction of the submenus

a)

b)

or

c)

or

d)

Figure 5.22 Construction of the submenus attached to the object contextual menu.

If the action proposed by the submenu can be applied to this atom/bond then the
first element of the menu is a line with the name of this atom/bond [Fig. 5.22-a]. The
second line [Fig. 5.22-b] refers, depending on the action of the submenu and/or the
status of the atom, to "selected" or "non-selected" atoms. The third line [Fig. 5.22-c]
follows the same idea for the "labelled" or "non-labelled" atoms. Finally the bottom
part [Fig. 5.22-c] refers to the coordinations and the chemistry of the considered object.
Most of the actions provided by these submenus being very intuitive, only the "Style"
and "Edit as new project" menus will be introduced in detail thereafter.
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5.2.2.1 The "Style" submenu

The "Style" submenu(s) of the object contextual menu allows to change the visual style
locally, ie. for an atom/bond, or any particular set of atom and bonds in the model.

Figure 5.23 The object contextual menu and the "Style" submenu(s).

Overall using local style(s) allows to improve the visual representation and to highlights
particular element(s) [Fig. 5.24].

Figure 5.24 Multiple visual styles the atomes program.
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The parameters of the local style(s), are inherited from the global style (see sec-
tion 5.1.1.1). Therefore in order to modify any parameters of a particular style, ie.
the sphere radius of an atom for the "Ball and stick" style, this style must be ap-
plied globally, and the appropriate parameters modified using the "model" menu (see
section 5.1.2) or the "Atom(s) configuration" dialog (Fig. 5.6). Afterwards and when
applied locally the "Ball and stick" style will use the new parameters. Note that
the default atomic radius for the "Spacefilled" style, even is this style is not used,
is the "Covalent" radius, following the local style menu’s behavior and if the global
"Spacefilled" style was not changed, then the local "Spacefilled" style(s) will use
the same parameters.

5.2.2.2 The "Copy" submenu

The "Copy" submenu(s) of the object contextual menu allows to copy atomic coordinates,
the copied data could then be re-used either using the "Model edition" dialog (see
section 6.1.3) or the mouse "Edition mode" (see section 6.2).

Figure 5.25 The object contextual menu and the "Copy" submenu(s).

Data can copied from any project, even from an MD trajectory however in that case only
the atomic coordinates from the visible MD step will be copied, other will be ignored.
Data can only be pasted in project(s) that support the "Edition mode" (see chapter 6).

5.2.2.3 The "Edit as new project" submenu

The "Edit as new project" submenu(s) of the object contextual menu allows to create
a new project using any particular set of atom and bonds in the model.
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Figure 5.26 The object contextual menu and the "Edit as new project" submenu(s).

Using any button of this menu the corresponding set of atom(s)/bond(s) will be
copied and exported as a new atomes project. This new project will immediately
be inserted in the workspace tree to be available for further work and a correspond-
ing 3D window will pop-up. Parameters of the initial project will be applied to the
new one (style, colors ...), except for the periodicity, if any, that will be lost in the process.

An example is proposed thereafter:

1. For this example the King’s rings statistics analysis (see section E.5) was performed
on SiO2 test system, afterwards the "Advanced environment" dialog was opened
and all atom(s) involved in ring(s) of size 6 atoms were selected (selection is
highlighted in light blue):
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2. After the selection, the object contextual menu is used to "Edit as new project"
the list of "All selected atom(s)/bond(s)":

3. The new project "Project N◦ 4" that contains the appropriate atom(s)/bond(s) is
created and inserted in the workspace tree, and the new OpenGL window pops
up:
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4. Finally after restoring the periodicity, it is possible to calculate any other properties
for the new model, ie. the selection from the SiO2 model, and compare the results
with one for the original system:
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5.3 Keyboard shortcuts

• Single key shortcuts:

– Colors:

a : change atom(s) colormap

p : change polyhedra(ons) colormap

– Styles:

b : change default style to "Ball and stick"

c : change default style to "Cylinders"

d : change default style to "Dots"

s : change default style to "Spheres"

o : change default style to "Covalent radius"

i : change default style to "Ionic radius"

v : change default style to "van Der Waals radius"

r : change default style to "In cristal radius"

w : change default style to "Wireframe"

– Measures:

m : show all measures for the selection, if pressed:

* once: display inter-atomic distance(s)

* twice: display inter-atomic angles

* a third time: hide measures

– Model rotation:

→ : rotate right

← : rotate left

↑ : rotate up

↓ : rotate down

• Misc:

Esc : exit fullscreen mode

: pause / restart spinning
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• Combined keys shortcuts:

– Mouse mode:

Alt + a : enter mouse "Analysis" mode

Alt + e : enter mouse "Edition" mode

– Selection:

Ctrl + a : select / unselect all atoms

Ctrl + c : copy all selected atom(s)

– Mouse selection mode:

Shift ⇑ + a : atom selection mode

Shift ⇑ + c : coordination sphere selection mode

Shift ⇑ + f : fragment selection mode

Shift ⇑ + m : molecule selection mode

– Camera motion:

Ctrl + → : move camera right

Ctrl + ← : move camera left

Ctrl + ↑ : move camera up

Ctrl + ↓ : move camera down

Shift ⇑ + ↑ : zoom out

Shift ⇑ + ↓ : zoom in

– Spinning:

Ctrl + Shift ⇑ + → : spin right / increase speed right or reduce speed left

Ctrl + Shift ⇑ + → : spin left / increase speed left or reduce speed right

Ctrl + Shift ⇑ + ↑ : spin up / increase speed up or reduce speed down

Ctrl + Shift ⇑ + ↓ : spin down / increase speed down or reduce speed up

Ctrl + s : stop spinning

– Misc:

Ctrl + l : label / unlabel all atoms

Ctrl + e : open the "Environments configuration" window [Sec. 5.1.3]

Ctrl + m : open the "Measures" dialog [Sec. 5.1.4]

Ctrl + r : open the "Recorder" dialog [Sec. 5.1.6]

Ctrl + f : enter / exit fullscreen mode
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In this chapter the examples will be illustrated using the same workspace used to illus-
trate the visual analysis capabilities of atomes in the previous chapter and presented
in figure 5.1.
Edition tools are available via the "Tools" menu, and using either the "Edit" submenu
[Fig. 6.1-a] or the mouse "Edition" from in the "Mouse mode" submenu [Fig. 6.1-b]:

a) b)

Figure 6.1 Accessing the edition tools in the atomes program.

6.1 The "Edit" submenu

6.1.1 The "Crystal builder" window

The "Crystal builder" button [Fig. 6.2] allows to open the corresponding window.

Figure 6.2 Accessing the "Crystal builder" window in the atomes program.
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Figure 6.3 The "Crystal builder" window in the atomes program.

The "Crystal builder" window [Fig. 6.3] allows the creation of crystalline structure(s)
and super-structure(s). Thus not only atom(s) but also molecules can be inserted to the
crystalline positions defined by the space group.
The "Select ..." menu allows to insert objects: atoms, molecules, and atom selections
from any other project opened in the atomes workspace. It will be presented in details
in section 6.1.3, at the exception of the "Empty site" button unique to the "Crystal
builder" and that will be introduced in the next pages related to the occupancy.
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Each object will be inserted at a position specified using the fractional coordinates, in
the proportion of the occupancy, and following the rules of the selected space group.
The following parameters can be adjusted:

1. The crystal system:

• Triclinic
• Monoclinic

• Orthorhombic
• Tetragonal

• Trigonal
• Hexagonal • Cubic

2. The type of Bravais lattice, depending on 1, in:

• Primitive
• Base-centered

• Body-centered
• Face-centered

• Hexagonal axes
• Rhombohedral axes

3. The space group, from 230 groups of the International tables for Crystallography
Vol. A, [29] and filtered using 1 and 2

4. The space group setting, if more than one is available.

5. The format of the lattice parameters:

• a, b, c and α, β, γ

• Vector components: a(x,y,z), b(x,y,z), c(x,y,z)

6. The number of cell(s) to replicate on a, b and c to create the final supercell.

7. If atomic coordinates are to be wrapped in the crystalline unit after building it.

8. If clones are to be shown afer building the crytal.

9. The object to insert to build the crystal using information specified at steps 1, 2,
3, 4 and 5, including the following options:

• The type of object (atom, molecule ...)

• The fractional coordinates of the object

• The occupancy of the crystallographic site (between 0.0 and 1.0)

• How to handle occupancy (if < 1.0), object(s) and/or empty position(s):

– "Random for the initial cell only": sites are filled randomly in the
initial cell only, then the initial cell is simply replicated.

– "Random cell by cell": sites are filled randomly for each cell, cell by
cell separately.

– "Completely random": sites are filled randomly for the entire network,
the final crystal is considered as whole.

– "Successively": sites are filled successively, all object(s) A are inserted
(for the first n(A) positions), then all object(s) B are inserted (for the next
n(B) positions) ...

– "Alternatively": sites are filled alternatively: object A is inserted on
the first position, object B is inserted on the second position, object A on
the third position, object B on the fourth position ... and so on.
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In any case the number n(A) of object(s) A to be inserted in calculated using:

n(A) =NP× occ(A)

NP is the number of position(s) to fill, occ(A) is the occupancy for object A.
Note that it is possible to adjust how the rounding is performed to determine
occupancy:

– Lowest integer: ⌊NP× occ(A)⌋
– Highest integer: ⌈NP× occ(A)⌉
– Nearest integer: ⌊NP× occ(A)⌉

Overlapping, object(s) on the same position, can also be allowed, the concept
will be illustrated in the following examples.

Using the crystal builder: space group information

Once a space group has been selected it is possible to access the "Space group info"
dialog using the "group info" button:

Figure 6.4 The "space group info" dialog for the R3̄c group in the atomes program.

The main information available is presented in the "space group info" dialog [Fig. 6.4],
including the different setting(s), and the corresponding initial coordinates and Wyckoff
positions.
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Using the crystal builder: building crystal(s)

The following pages will present crystal building examples using the Fd3̄m (origin 1
setting) space group (diamond-like structure):

1. The C-diamond structure:

Figure 6.5 Building a C-diamond crystal in the atomes program.

The following steps are required to build the C-diamond crystalline structure (see
figure 6.5-left):

• Select the Fd3̄m space group ("Cubic -> Face-centered -> 227: Fd-3m")
• Set the value for the lattice parameter: ≃ 3.5 Å
• Insert a C atom at (0.0, 0.0, 0.0) with occupancy to 1.0, you can edit both

coordinates and occupancy by double-clicking on the corresponding line.
• Select the "Insert check button" to use the atom to build the crystal, or

alternatively click to top of the "Insert" column to insert all elements.
• Finally simply click on the "Build / Build (new project)" button.

The crystal is then displayed (see figure 6.5-right), also clones (atoms linked using
the PBC see section 5.1.2.3) are immediately shown. The existence of a chemical
bond depending on the cutoff(s), determined automatically when creating the
crystal, you might need to adjust the values to define properly the bonding of the
system.
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2. The C-diamond structure, playing with occupancy:
In these examples the parameters to build the crystal remain exactly similar to 1,
only the total number of cells will be increased to 2 on a:

• Occupancy = 1.0:

With 8 atoms per cell, the total number of atoms in the system is equal to 16.
• Occupancy = 0.5:

With an occupancy of 0.5 the number of atoms per cell will be reduced to 4,
and the total number of atoms in the system to 8.
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(1) =⇒

"Random for the initial cell only":
The same treatment is applied to each cell, inducing an overall symmetry.
The system is not disordered with 4 atoms per cell at the exact same positions.

(2) =⇒

"Random cell by cell":
A random treatment is applied to each cell independently.
The system is disordered, but the number of atoms per cell remains equal to 4.

(3) =⇒

"Completely random":
The system is entirely disordered.
The average value 0.5 C atoms per site is respected for the entire structure,
but the number of atom(s) per cell can change.
This option if particularly useful when the occupancy for a particular site is very low,
see the section remarks afterwards for more information.
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To illustrate (4) "Successively" and (5) "Alternatively" it is interesting to
use more than one chemical species:

Adding O atoms: Adding O and N atoms:
For all chemical species: For all chemical species:

- The occupancy is equal to 0.5 - The occupancy is equal 0.333
- The site is the same (0.0, 0.0, 0.0) - The site is the same (0.0, 0.0, 0.0)

⇓ ⇓

⇓ ⇓

In both cases (4) "Successively" and (5) "Alternatively":

The system is ordered.
The average values of the occupancy per site are respected for the entire
structure.
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• The C-diamond structure, playing with molecules:
As already mentioned atomes does not only allow to build atomic crystalline
structures but also molecular crystalline super-structures.

Figure 6.6 Building a C-diamond like C60 crystalline super-structure.
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The "Insert..." menu allows indeed to insert fragments from the library or
from any project opened in the workspace.
Using C60 fullerene molecules instead of carbon atoms (and increasing the
lattice parameter appropriately) allows to obtain the structure illustrated in
figure 6.6.
As for the atom(s) tweaking the occupancy can be useful with molecules:

Using the (4) "Successively" occupancy set-up, you build:

Figure 6.7 Building a C-diamond like, alternating C60 and toluene molecules, crystalline
super-structure.

• The C-diamond structure, molecules and overlapping:
As mentioned using the "Allow overlapping" option allows to insert at the
same crystalline positions. The interest is limited to molecules-molecules
overlapping or molecules-atoms overlapping, there is no point in getting
two atoms at the same position. The idea behind this concept is to allows
the encapsulation of an object by another one:
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Figure 6.8 Building a C-diamond like, toluene encapsulated C240, crystalline super-
structure. The "Molecules" color-map (see sec. 5.1.1.2) for atoms and bonds is
used for clarity purposes. 81



Visual edition in atomes 82

Notes:

• Crystal building: for more on the crystal building process see appendix D.

Here are some important things happening when building a crystal in atomes:

– At the beginning of the process the size of the object(s) to insert is compared
to the lattice parameters, if the lattice parameters are considered too small a
warning message will pop-up:

* For an atom, the size is set to 1.0 Å.

* For a molecule, the size is the maximum interatomic distance within the
molecule.

The process is not fail-safe, and without being careful it is possible to build
a crystal with an improper bonding.
The distance matrix calculation to determine bonding information is per-
formed on the fly at the end of the building process, if the crystal bonding
is too bad, this calculation could fail and no bond will be display. If the
crystalline structure is good, then simply correct the bond cutoff to perform
the calculation again, and get the correct bonding information.

– At the end of the process all the atoms are wrapped back in the unit cell.
– The bond cutoff are determined automatically, therefore the visual aspect

of the final structure might be misleading, with too much of too few bonds
compared to what was expected.

– When inserting a molecule remember that there is not way to determine its
orientation, with water molecules for instance it might be required to rotate
the molecule(s) afterwards, see section 6.1.3 for more information.

• Occupancy: as illustrated previously the order the object(s) is(are) inserted on the
crystalline positions might have an importance on the final structure. This is true
when the occupancy is < 1.0 and / or when object can share the same site when
using the "Allow overlapping" option.
To ensure that the desired crystal will be built, either insert the object in the proper
order or re-order them using the mouse drag an drop:

The occupancy occ(s) for a site s (xs, ys,zs) is defined as:

occ(s) =
N∑

i=1

occ(i) (6.1)

for the N object(s) on the same site (xs, ys,zs)
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• Empty position: the "Empty position" button of the "Select ..." menu is used
to force the insertion of empty position(s).
The empty site(s) are always treated before any object insertion(s), even if the
position in the insertion tree is not on top.
In the case of "Overlapping"+"Empty position" the rules for occupancy are
modified as follow:

occ(s) =
N

max
i=1

occ(i)+
E∑

j=1

occ( j) (6.2)

for the N object(s) and E empty positions on the same site (xs, ys,zs).

6.1.2 The "Cell edition" window

The "Cell edition" window allows to adjust many parameters related to the period-
icity of the material, and is accessible using any of the buttons of the "Cell" submenu
[Fig. 6.9].

Figure 6.9 Accessing the "Cell edition" window in the atomes program.

Each of the buttons in the "Cell" menu [Fig. 6.9] allows to open the corresponding tab
in the "Cell edition" window.
Each of these tabs and the action they provide will be introduced in the following:

• The actions of the "Cell edition" window are accessible if and only if there is a
model box.

• The actions "Create super-cell", "Adjust density" and "Cut slab" are not
available in the case of MD trajectory.
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Wrap all atoms in

The "Wrap all atoms in" button allows to wrap all atomic coordinates in the original
unit cell.

1. As illustrated bellow MD codes sometimes output MD trajectory / atomic co-
ordinates in real coordinates, the visual assessment of such trajectory / atomic
coordinates becomes complicated:
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2. To simplify the visual analysis atomes can put back all atoms back in the unit
cell using the periodicity and the box parameters as described in the "Box and
periodicity" dialog [Fig. 3.5].
Simply select the "Wrap atomic coordinates in unit cell" menu item from
[Fig. 6.9]:

The action being irreversible it is required to confirm it:

3. After confirmation the operation is performed and the OpenGL window updated:
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Shift center

The "Shift center" tab allows to shift the atomic coordinates within the unit cell:

=⇒

w

=⇒

It is possible to shift atomic coordinates along the x, y and/or z model axis. The
periodicity is preserved and if needed bonding properties are re-evaluated on the fly
during this operation.

Note that it this required to wrap the atomic coordinates in the unit cell before
being able to shift them.
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Add extra(s)

=⇒

w

=⇒

w

=⇒
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The "Add extra(s)" tab allows to add extra unit-cell(s) to the model, any object visible
within the original unit cell will be duplicated (atom, bond, polyhedra, measure, label
...) as well. The duplicates cells are slightly translucent compared to the initial unit cell.

Create super-cell

The "Create super-cell" button allows to change the periodicity of the system and
transform the unit cell to the extended structure created after using the "Add extra(s)"
tab.

Adjust density

The "Adjust density" tab allows to modify the density of the material using homoth-
etic rescaling that can be:

• Homogeneous: the a
b and a

c ratio of the initial unit cell are preserved

• Heterogeneous: a, b, and c are adjust individually

Note that to perform this operation any bonding information will be lost, and only
the visual information will not be immediately erased. Therefore it is strongly recom-
mended to recompute the bonding proprieties afterwards, this can not be done on the
fly because changing the density is likely to require to change the bond cutoffs as well.
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=⇒

⇑

=⇒

⇓

=⇒
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Cut slab

The "Cut slab" tab allows in the model using geometric patterns: parallelpiped, cylin-
drical and spherical. The "Cut slab" tab displays slab information, including slab
volume and the number of atom of each chemical species inside it. The values are
refreshed each time the shape, position size, and/or rotation of the slab is modified.
Examples are presented in figure. 6.10.

6.1.3 The "Model edition" window

The "Model edition" window offers several tools dedicated to the edition of the atomic
coordinates and is accessible using any of the buttons of the "Atom" submenu [Fig. 6.11].

It is not possible to access the "Model edition", and therefore to move / replace / remove
and insert atom(s) in the case of MD trajectory.

Selection process

When the "Atom edition" window is opened the main OpenGL window remains
active, and it is still possible to work in it. However having the "Model edition"
window opened will modify the results of the atom selection process, whether is it
performed using any dialog window or using with the mouse describe in section 5.2.1
and 5.2.2. The newly extra-selected atom(s) will be covered in pink (instead of light
blue), see [Fig. 6.12], and even already selected atoms (in light blue) can be re-selected.
As long as the "Model edition" window remains open, the "Measures" dialog [Fig. 5.10]
will only presented measurement(s) related to the new pink atoms.
The utilization and purpose of this extra selection feature will be illustrated when
presenting the action tabs of the "Model edition" window.

General behavior

Before browsing each and every tab of the "Model edition" window it is required to
introduce the "atom search" tool [Fig. 6.13] common to almost every tab (in the top
part) in the window. Each tab being dedicated to a particular action the search tool will
help to find and selected the atom(s) you want the action to be performed upon:

1. Search for atom(s) among [Fig. 6.13-1]:

(a) non-selected atom(s) only: search only in "All non-selected atoms"
[Fig. 6.13-1]

(b) selected atom(s) only: search only in "All selected atoms" [Fig. 6.13-1]

(c) or all atoms: search in all "All atom(s)" [Fig. 6.13-1]

1b is the default value for menu [Fig. 6.13-1] if some atoms are selected, and 1c is
the default value otherwise.
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Figure 6.10 Model edition using the "Cut slab" tab, from left to right: 1) all atoms outside
the sphere are deleted, 2) atoms inside the cylinder are selected, 3) all atoms in
the parallelpiped slab are deleted and the results is exported in a new project.

2. Apply the action to [Fig. 6.13-2]:

(a) The atoms as single object(s): pick "Atom(s)" [Fig. 6.13-2]

(b) Group of atom(s): pick "Group of atoms" [Fig. 6.13-2]

In case 2a the action will be performed on the atom(s) that will be selected and
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Figure 6.11 Accessing the "Model edition" window in the atomes program.

a) b)

=⇒

c)

v w

Figure 6.12 Modified selection process when the "Model edition" window is opened.

each of these atoms will be treated as an isolated object. In case 2b the action
will be performed on the group(s) of atoms, the atom(s) that will be selected
afterwards belong to: entire coordination sphere(s), fragment(s) or molecule(s).

3. Filter the result of the search depending on the type of object you are interested
in figure 6.13-3:

(a) Chemical species (Available only if 2a is selected for [Fig. 6.13-2])

(b) Total coordination

(c) Partial coordination

(d) Fragment

(e) Molecule

Pick the appropriate value in figure 6.13-3 and the selection tree bellow will be
updated accordingly.
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Figure 6.13 The atom(s) search tool.

4. Refine the search to present only the atom(s) of that particular chemical species (if
2a was selected in figure 6.13-2) or the group of atoms that contains such chemical
species (if 2b was selected in figure 6.13-2)

Notes:

• Clickable : some of the column headers in the search tree are clickable, in the top
part if you click on the "Label" or "Move" the corresponding action will be applied
/ unapplied to the entire data set available in the search tree.

• Update : whenever the values for the menus 2 [Fig. 6.13-2] and 3 [Fig. 6.13-
3] are modified the tree is not only refreshed but also cleaned, and so is the
corresponding data thus previous selection sets would be lost in the process.

Examples of the utilization of the "atom search" tool [Fig. 6.13] will be presented along
with each actions available in the "Model edition" window.
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The "Move" tab

The "Move" tab allows to move atom(s) (translation only) or group of atoms (translation
and rotation around the groups barycenter). In the following example one of the
fragment in the model is selected, the fragment appears to be split because of the
periodic boundary conditions:

Figure 6.14 Initial position with an isolated fragment selected in the model.

To move the selected fragment:

1. Open the "Move" atom(s) tab:
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2. Go back to the main OpenGL window, keeping the "Model edition" window
opened, and select few atoms, that will appear in pink color. Then open the
"Measures" dialog [Fig. 5.10] to select a bunch of measurements to be displayed:

3. Go back to the "Model edition" window and adjust the search "For" option and
select "Group of atom(s)":

4. Adjust the search "Filter by" option and select "Fragment":
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5. Then select the fragment in the selection tree:

6. Open the lower part(s) to move the fragment:

96



97 6.1. The "Edit" submenu

Figure 6.15 Final position of the fragment, after translation and rotation in the model.

Notes:

• Motion axis: it is possible to select (and visualize) the motion axis and choose
between the "Eye (viewer) axis" and the "Model axis" (real x, y and z of the
atoms).

• Motion actions: the motion interactors (ranges and input entries) allow to adjust
motion very precisely, slightly more approximate motion is also available using
the mouse (see Sec. 6.2)

• Measurements: if already present in the OpenGL window, measurement(s) are
updated on the fly, allowing to adjust perfectly position and orientation of the
object in the model, see [Fig. 6.15].

• Motions: translation is always available, however rotation is only available for
"Group of atom(s)" and is performed around the barycenter(s) of the object(s)
to be rotated.

• Reconstruction: the check button labelled "Extract/rebuild the object(s) to
be moved, ie. cut/clean bonds with nearest neighbor(s)" offers the fol-
lowing option:

– For "Atom(s)": if activated the object(s) to be moved will be extracted from
the model and translated independently, otherwise chemical bond(s) will
simply be stretched.

– For "Group of atom(s)": if activated the atomic positions of the object(s)
will be corrected to get only single piece object(s).
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As illustrated in figure 6.14 the fragment visually appears in 2 pieces, and as
illustrated by the example as a single piece object after motion [Fig. 6.15].
If the object(s) to be moved are coordination spheres and if the spheres that are
being moved share atom(s), then the positions of these atoms might be affected
twice by this procedure, leading to an awkward, yet correct, 3D representation.

• Bonding: During motion, the coordination information is modified, all related
menus and corresponding dialogs are updated accordingly, however detailed
bonding information is lost. It is therefore strongly recommended to recompute
bonding properties afterwards.
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The "Replace" tab

The "Replace" tab allows to replace object(s), atom(s) or group of atoms, by either:
atom(s), molecules imported from the internal library or atom(s) imported from any
project opened within the same instance of the atomes program:

Figure 6.16 The "Replace" tab, with the option of replace objects "Normally", ie. object
by object, or "Randomly", in the model.

As illustrated in figure 6.16 it is possible to replace object(s) one by one ("Normally")
or by random pick ("Randomly"). The difference between the normal and the random
search trees are illustrated in top part of figure 6.17.
For normal substitution(s) [Fig. 6.17-a] it is possible to select the replacement object(s)
either at once for all objects, using the "Select for all ..." menu, or alternatively
one by one when browsing the tree and using the "Select ..." menu(s).
For random substitution(s) [Fig. 6.17-b] only a single replacement is selected for each
type of object, and it is require to enter the number of substitution(s) to be performed.
The substitution options accessible using the "Select ..." menu are illustrated in the
bottom part in figure 6.17 with the different "atoms" c), "Library" d) and "Import from
project" e) submenus.
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a) b)

c)

d)

e)

f)

Figure 6.17 Top: search trees a) replacing object(s) one by one, b) replacing object(s) ran-
domly. Bottom: the "Select for ..." replacement menu and the attached c)
"Atom", d) "Library", e) "Import from project" and f) "Copied data"
submenus.
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Substitution options

• The "Atom" submenu [Fig. 6.17-c], to insert a new atom in place of the object(s)
to be removed. Some shortcuts are proposed, if required the "Other ..." button
allows to open a periodic table to pick any appropriate atom:

• The "Library" submenu [Fig. 6.17-d], to insert an new molecule in place of the
object(s) to be removed. Some shortcuts are proposed as well, and the "More ..."
button allows to open the "Library" dialog:

The "Library" dialog provides a bunch of sample molecules roughly sorted by
chemical properties (see appendix C for more details).

• The "Import from project" submenu [Fig. 6.17-e], to insert atom(s) from any
atomes project opened in the workspace.

• The "Copied data" button [Fig. 6.17-f], to copied data selection from any
workspace in atomes.
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An example is provided in figure 6.18 with the random substitution of 500 "Si" atoms
from the "SiO2" project by "water" molecules.

Figure 6.18 Random substitution of 500 "Si" atoms by "water" molecules.
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Notes:

• Irreversible: the replacement is irreversible (at least not directly, but it is always
possible to perform another backward substitution) therefore remember to save
your work before replacing any object(s) in your model.

• Selection: At the end of the substitution process, and therefore after the insertion
of the new objects, all these new objects will appear surrounded by light blue
color in the OpenGL window (see figure 6.18), and will therefore be selected,
making further work on these new objects easier.

• Barycenters: the new object is inserted and centered at the barycenter of the
atomic positions of the old object to be removed.

The "Remove" tab

The "Remove" tab allows to remove object(s), atom(s) or group of atoms, like for the
"Replace" tab the action can also be performed randomly. An example is provided in
figure 6.19 with the normal (one by one) removal of all "Ni-[N4]" coordination spheres
atoms from the "Ni-Phth" project: for a Nickel atom, this means that this "Ni" atom as
well as it surrounding "N" neighbours are all removed.

Figure 6.19 Normal removal of all "Ni-[N4]" coordination spheres from the model.
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The "Insert" tab

The "Insert" tab allows to insert new object(s) in the model:

Figure 6.20 The "Insert" tab, with the options to choose the object to be inserted and the
position of insertion.

The "Select ..." menu reproduces the one from the "Replace" tab, see the bottom
part in figure 6.17, and allows to insert atom(s) [Fig. 6.17-c], molecular fragment(s)
[Fig. 6.17-d] and atom(s) from any other project opened in the workspace [Fig. 6.17-e].
Selecting any object to insert will populate and update the tree bellow, with a new line.
Each line describes the object to be inserted, and offers options to confirm the insertion
and specify the position where to insert the object in the model.
An example is provided in figure 6.21 where a fullerene "C240" is inserted in the
"Ni-Phth" project modified after the removal example illustrated in figure 6.19.
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Figure 6.21 Insertion of fullerene "C240" in the "Ni-Phth" project modified after the removal
example illustrated in figure 6.19.

Notes:

• Irreversible: the insertion is irreversible (at least not directly, but it is always
possible to remove all inserted atoms) therefore remember to save your work
before inserting any object(s) in your model.

• Selection: After the insertion of the new objects, all these new objects will appear
surrounded by light blue color (see figure 6.21)in the OpenGL window, and will
therefore be selected, making further work on these new objects easier.

• Position: the coordinates (0.0, 0.0, 0.0) always refers to the center of the model, ie.
the barycenter of all existing atomic coordinates.
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The "Random move" tab

The "Random move" tab allows to disorder the model:

Figure 6.22 The "Random move" tab. With "atom(s)" selected as object(s) it is only
possible to translate randomly, with "Group of atoms" it is also possible to
rotate randomly and the corresponding column appears in the search tree.

An example is provided in figure 6.23 with the random rotation of "water" molecules
in the modified "SiO2" project after the substitution example illustrated in figure 6.18.
Indeed after the substitution "water" molecules were all perfectly aligned, to correct
this unlikely organization atomes can rotate randomly and independently every water
molecule in the model:

1. After the substitution all the "H" and "O" atoms of the newly inserted "water"
molecules are selected, so search for selected atom(s) only [Fig. 6.13-1].

2. Then choose to apply the action to "Group of atoms" [Fig. 6.13-2].

3. Filter the selection using the "Fragment" option [Fig. 6.13-3].

4. After the steps 1, 2 and 3 the selection tree will correspond to the one in figure 6.23.
To enable the random rotation simply click on the top header of the "Rotate"
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column to select all object(s), actually all "water" molecules. It is required to enter
a maximum MSD for each motion, click the top header of the "MAX. MSD" column
to enter a suitable value. Optionally it is possible to iter the rotation process, at
each step the rotation will be completely random.

Figure 6.23 Random rotation of "water" molecules in the "SiO2" project modified after the
substitution example illustrated in figure 6.18.
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Notes:

• Group of atoms: trying to move group of atoms that share atom(s) (ex: 2 coordi-
nation spheres with atom(s) in both coordination spheres) can lead to inaccurate
results, the shared atom(s) being moved with each object they belong to.

• Rotation: the rotation is performed around the positional barycenter of the ob-
ject’s atomic coordinates. In the case of a repeated rotation the rotation center is
preserved until the final step to avoid drifting. If both translation and rotation
are repeated then the object is translated first, updating as well the position of the
rotation center, and then rotated.

• Reconstruction: the check button labelled "Extract/rebuild the object(s) to
be moved, ie. cut/clean bonds with nearest neighbor(s)" offers the fol-
lowing option:

– For "Atom(s)": if activated the object(s) to be moved will be extracted from
the model and translated independently, otherwise chemical bond(s) will
simply be stretched.

– For "Group of atom(s)": if activated the atomic positions of the object(s)
will be corrected to get only single piece object(s).
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6.1.4 The "Extract/rebuild" buttons

As introduced in the previous pages these buttons allows to extract object(s) to be
moved or copied/pasted from the model, into single piece object(s). The effect on
motion is illustrated in sections 6.1.3 and 6.2.1, the effect on copy is the following:

Figure 6.24 Illustration of the rebuild process, a fragment is copied from the top figure and
pasted back in new projects. That fragment appears split because of the PBC: on
the left the fragment is rebuild as a singe object, on the right the 2 pieces remain
separated.
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6.2 Mouse interaction with the OpenGL window: edition

It is possible to activate the mouse "Edition" using the "Tools" menu:

a)

b)

=⇒

Figure 6.25 a) Activating the mouse "Edition" mode using the "Tools" menu. b) when
switching mode the title bar of the OpenGL window changes.

It is also possible to use the Alt + e keyboard shortcut, and to switch back to
"Analysis" mode using the Alt + a shortcut.
In "Edition" mode the mouse button functions are the following:

• Left button

– Single click on object: object selection

– Pressed on background + motion: selected (only) atomic coordinates rotation ∗

• Scroll button

– Scrolled: zoom in/out

– Pressed + motion: selected (only) atomic coordinates translation

• Right button

– Pressed on background: edition contextual menu

– Pressed on object: object edition contextual menu

∗ The rotation is performed around the coordinates barycenter of the selected atoms.
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6.2.1 Atom selection

As for the "Analysis" mode object(s) can be selected using the mouse left click. In
"Edition" mode selected atoms/objects are subjects to motion interactions using the
mouse and it becomes complicated to check motion information with visual measure-
ments. However using the "Tools" menu it is possible to activate the "Measures"
selection mode (available when using the "Model edition" dialog (see section 6.1.3):

Figure 6.26 Activating the "Measures" selection mode using the "Tools" menu.

The following provides an example of utilization of the "Measures" selection mode:

1. Select a fragment in the model:
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2. Switch to "Edition" mode (if not done already) and change the "Mouse selection
mode" to "Measures (Edition mode only)". Then select some atoms in the
model, and open the "Measures" dialog (see section 5.1.4) to display some mea-
surements:

3. Start to move the selected fragment using the mouse left click+motion to rotate
or mouse scroll click+motion to translate, by default, and if divided because of
the PBC, atomes will reconstruct the fragment (see figure 6.27 to modify that
behavior):

4. You will see that when moving the fragment with the mouse the information
displayed (inter-atomic distances and angles) is instantaneously refreshed:
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6.2.2 The edition contextual menu

The mouse right click button on the background of the OpenGL window opens the
edition contextual menu:

a)

b)

Figure 6.27 The right button contextual menu on the background of the OpenGL window.

• The "Tools" submenu [Fig. 6.27-a] reproduces the corresponding top bar menu.

• The "Insert" submenu [Fig. 6.27-b] offers shortcuts to insert objects in the model,
and is similar to the "Select ..." menus described in section 6.1.3 for the
"Replace" and "Remove" tabs of the "Model edition" dialog.

• The "Extract/rebuild on motion" button:

– For "Atom(s)": if activated the object(s) to be moved will be extracted from
the model and translated independently, otherwise chemical bond(s) will
simply be stretched.

– For "Group of atom(s)": if activated the atomic positions of the object(s)
will be corrected to get only single piece object(s).

• The "Reset motion" button will reset all atomic coordinates to the value imme-
diately saved when:

– Entering the "Edition" mode: if no atoms were inserted or removed in the
model.

– Replacing/removing/inserting atom(s): if any atom was inserted or removed
in the model.
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6.2.3 The object edition contextual menu

Pressed over any atom/bond the right button opens the object edition contextual menu:

a) b)

Figure 6.28 The object edition contextual menu: a) for an atom, b) for a chemical bond.

The object edition contextual menu in figure 6.28 follows exactly the construction
described in section 5.2.2 and 5.2.2 for the object contextual menu in "Analysis" mode.
The object edition contextual menu offers shortcuts to "Remove", "Replace" and "Copy"
object(s) in the model.
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6.3 Keyboard shortcuts

• Single key shortcuts:

– Colors:

a : change atom(s) colormap

p : change polyhedra(ons) colormap

– Styles:

b : change default style to "Ball and stick"

c : change default style to "Cylinders"

d : change default style to "Dots"

s : change default style to "Spheres"

o : change default style to "Covalent radius"

i : change default style to "Ionic radius"

v : change default style to "van Der Waals radius"

r : change default style to "In cristal radius"

w : change default style to "Wireframe"

– Measures:

m : show all measures for the selection, if pressed:

* once: display inter-atomic distance(s)

* twice: display inter-atomic angles

* a third time: hide measures

– Atomic coordinates rotation:

→ : rotate atomic coordinates right

← : rotate atomic coordinates left

↑ : rotate atomic coordinates up

↓ : rotate atomic coordinates down

– Misc:

Esc : exit fullscreen mode

Del : Delete all selected atom(s)
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• Combined keys shortcuts:

– Mouse mode:

Alt + a : enter mouse "Analysis" mode

Alt + e : enter mouse "Edition" mode

– Selection:

Ctrl + a : select / unselect all atoms

Ctrl + c : copy all selected atom(s)

Ctrl + v : paste copied selection (if the model is not a MD trajectory)

Ctrl + x : copy, then delete selection

Ctrl + n : create new (empty project)

– Atomic coordinates translation:

Ctrl + → : translate atomic coordinates right

Ctrl + ← : translate atomic coordinates left

Ctrl + ↑ : translate atomic coordinates up

Ctrl + ↓ : translate atomic coordinates down

Shift ⇑ + ↑ : zoom out

Shift ⇑ + ↓ : zoom in

– Misc:

Ctrl + l : label / unlabel all atoms

Ctrl + e : open the "Environments configuration" window [Sec. 5.1.3]

Ctrl + m : open the "Measures" dialog [Sec. 5.1.4]

Ctrl + r : open the "Recorder" dialog [Sec. 5.1.6]

Ctrl + f : enter / exit fullscreen mode
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Preparing molecular dynamics
calculations in atomes

atomes proposes assistants dedicated to the creation/preparation/modification of input
files for (massively parallel) molecular dynamics calculations:

• Classical MD:

– DL-POLY [1]

– LAMMPS [2]

• ab-initio MD:

– CPMD [3]

– CP2K [4]

• QM-MM (Mixed ab-initio - classical) MD:

– CPMD [3]

– CP2K [4]

7.1 Classical MD

7.1.1 DL-POLY v4.09

The atomes helper for the DL-POLY calculation offers to prepare input files for DL-
POLY v4.09. The CONTROL, FIELD and CONFIG files can be entirely designed.
Before going further it is strongly advised to read the DL-POLY user manual:

ftp://ftp.dl.ac.uk/ccp5/DL_POLY/DL_POLY_4.0/DOCUMENTS/USRMAN4.pdf

7.1.1.1 Initializing the force field

The mandatory first step in the DL-POLY calculation assistant is to initialize the force
field, as illustrated in figure 7.1 it required to select both:
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Figure 7.1 Initializing the force field in the DL-POLY calculation assistant.

• The force field to be used, ie. the data source for many of the "FIELD" file
parameters including: bonds, angles, dihedrals and inversions.
The FIELD file parameters can be imported from the following force fields:

– OPLS force fields:

* OPLS All-atoms for proteins

* OPLS All-atoms for RNA

– CHARMM force fields:

* CHARMM 22 proteins

* CHARMM 22 proteins and metals

* CHARMM 35 ethers

* CHARMM 36 carbenes

* CHARMM 36 general

* CHARMM 36 lipids

* CHARMM 36 Nucleid acids

* CHARMM 36 proteins

* CHARMM 36 proteins and metals

* CHARMM silicates

– AMBER force fields:

* AMBER 94

* AMBER 96

* AMBER 98

* AMBER 99

– Consistent force fields:

* CVFF

* CVFF Augmented

* CFF 91

* PCFF

* COMPASS
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Theses parameters are read by atomes on the fly / by request from the corre-
sponding files located in the directory: "bin/library/force_fields".

• The atoms description to initiate the force field, ie. the first "rough" type of field
atoms for the initial description of the force field:

– The atomic species

– The atomic species and the total coordination(s)

– The atomic species and the partial coordination(s)

Once the force field has been initialized the default pages populates the assistant:

Figure 7.2 The initialized force field in the DL-POLY calculation assistant.

7.1.1.2 The "CONTROL" file

When the force field has been initialized and providing the "CONTROL" file is to be pre-
pared, it is possible to adjust the corresponding options.
These options are regrouped in 8 tabs illustrated in figure 7.3, and almost all options
from the DL-POLY user guide are available, with the exception of the Plumed calcula-
tion options and some options for the two-temperature "ttm" model.
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Figure 7.3 The "CONTROL" file options in the DL-POLY calculation assistant.
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7.1.1.3 The "FIELD" file

If the "FIELD" file is to be prepared then the corresponding tabs are also made available
in the assistant.

Force field elements

The first tab related to the "FIELD" file allows to enable or disable all kind of compo-
nent(s) for the force field to be created:

Figure 7.4 "Select the component(s) of the force field" tab in the DL-POLY
calculation assistant.

The "Energy unit" combo box, allows to change the energy units for the field parame-
ters, please note that changing the energy unit will convert all parameters in the "FIELD"
file to the new unit.

The other options are divided in 2 categories, the "Intra-molecular interaction(s)"
options and the "Non-bonded interaction(s)" options. To enable / disable any feature
simply check / uncheck the corresponding button in this tab, then the associated page
will be inserted / removed from the list of pages available in the assistant.
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General behavior of the "FIELD" file part of the assistant

Each page of the assistant is dedicated to a particular property, the first pages (up to
13 pages) being dedicated to intra-molecular interactions and the latest pages (up to 6
pages) being dedicated to non-bonded interactions.

Each page contains a table presenting the list of the associated properties, double
clicking on a line with the mouse left button will allow to edit the corresponding
line/property, while the mouse right button will open a contextual menu with different
set of actions including the edition available otherwise.

For almost each and every intra or inter-molecular property listed in the corresponding
tab, corresponds a "Use" check button. It is mandatory to check-in the "Use" button for
the property to be used when building the "FIELD" (remember that few are mutually
exclusive), if not then the information is simply stored for further usage.

Any objects selection is associated with a visualization in the model, ie. if an atom/a
bond/an angle ... is selected then this object will be highlighted with a particular color
in the 3D window, also the associated line in the selection dialog will be colored as well
and using the same color.

Each page will be briefly introduced thereafter.

The "Molecule(s)" tab

The "Molecule(s)" tab, see figure 7.5, lists all the different molecules in the model:

Figure 7.5 "Molecule(s)" tab in the DL-POLY calculation assistant.
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Each line corresponds to a molecule, and for each molecule the information is as follow:

1. ID in the force field

2. Name in the force field (can be changed by double clicking on the line)

3. Multiplicity (number of times the same molecule appears in the model)

4. Chemistry

5. Total number of atoms

6. Number of chemical species

7. Check button to visualize the molecule in the model

8. Check button to visualize the atom number within the molecule

In the "Ni-Phth" example used here, two distinct molecules are found, 8 identical
and standard Ni-phthalocyanine molecules that constitute the bottom surface and 1
modified Ni-phthalocyanine molecule, with a H atom missing on top of it.
As illustrated in figure 7.6 the effect of the first check button 7 is to help visualizing the
different molecule(s) in the model. For each molecule a color is defined and applied to
both the atom(s) in the model and the corresponding line in the "Molecule(s)" tab.

Figure 7.6 Visualizing the "Molecule(s)" using the DL_POLY calculation assistant.

Whereas as illustrated in figure 7.7 the effect of the second check button 8 is to help
visualizing the atom numbers as assigned in the "FIELD" file, numbers range from 1 to
the total number of atom(s) in the molecule.
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Figure 7.7 Visualizing the atom(s) number(s) within the "Molecule(s)", to clarify the
representation a single fragment from the "NiPhth" example is displayed.

Some mouse options are available in the "Molecule(s)" tab:

• Double click anywhere on the line to edit the name of the molecule.

• Use the right click to open the contextual menu to edit the name/add/remove
molecule(s).

As illustrated in figures 7.8 and 7.9 it is possible to add molecule(s) to the force field, or
to merge existing molecules from the force field into a single description:

• Providing that the multiplicity of a molecule is higher than 1, and therefore
than several identical molecular fragment exist, it is possible to split the existing
molecule, preserving the old description for the non-selected fragment(s) and
creating a copy for the selected fragment(s). This process is illustrated in figure 7.8.

• Providing that some molecules in the force field have the same chemistry and
connectivity it is possible to merge the description this two separates molecules
as one. This process is illustrated in figure 7.9.
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Figure 7.8 Adding molecules to the force field using the DL_POLY calculation assistant.
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Figure 7.9 Merging molecules from the force field using the DL_POLY calculation assistant.
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The "Atom(s)" tab

When molecules have been properly defined, the next tab allows to configure the
atom(s) description, this has to be done for each molecule:

Figure 7.10 The "Atom(s)" tab in the DL-POLY assistant.

As illustrated in figure 7.10 the first element to notice in the "Atom(s)" tab is the combo
box for the choice of the molecule to work on, that same combo box will be inserted in
any tab dedicated to intra-molecular interactions.

Each line corresponds to a particular atom for the molecule specified above, and
for each atom the information is as follow:

1. ID in the molecule

2. Name in the molecule

3. Element

4. Mass

5. Charge

6. Number of frozen atoms for this type

7. Total number of atoms for this type

8. Check button to visualize the atom in the model
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Figure 7.11 Inserting a new atom description in the "Atom(s)" tab.
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Figure 7.12 Merging two existing atom descriptions in the "Atom(s)" tab.
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Before editing an atom property it might be necessary to add or remove some atom
types from the existing description, these actions are available using the mouse right
button contextual menu. As illustrated in figure 7.11 it is possible to create a new type
of atom from an existing atom type that contains more that 1 atom. And as illustrated
in figure 7.12 it is possible to merge an existing atom description with any other atom
type of the same chemical species. Whether it is for inserting or merging an atom it is
important to specify that all existing atomic descriptions, a part for the new one or the
one to be removed, will be preserved and thus that no information will be lost in this
process.

Editing an atom properties, by double clicking on the atom line or using the con-
textual menu, will open the "Atom parameter(s)" dialog:

Figure 7.13 Editing an atom description in the "Atom(s)" tab.

The "Field parameters" combo allows to switch between "Manual" (user defined only)
and "Automatic" force field parameters (if any available). By default the choice is set on
"Manual" and the "Force field type" combo is inactive. The "Frozen" button allows
to pick atom(s) to be frozen among the edited atom type (see figure 7.13).
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When selecting "Automatic" for the "Field parameters" combo, providing that some
force field parameters are found "Force field type" combo becomes active and offers
to choose between available description(s):

Figure 7.14 Choosing a force field description for the atom type in the "Atom(s)" tab. In
this example available parameters are from the Amber 99 force field.

As soon as a selection has been made a dialog (see fig. 7.15) pops up to update the
"FIELD" file with the available parameters in the force field selected at the initializing
stage of the assistant (Amber 99 in this example).

Figure 7.15 The "Update FIELD file with the force field parameters" dialog.
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The number of lines in the table in figure 7.15 depends on both the option(s) ("Flexible
chemical bond(s), Bond angle(s) ...") selected to create the "FIELD" file, the line
will appears only if the option was selected, and the availability of the data for that
particular type of atom in the selected force field. In this example all the properties
presented were selected to create the "FIELD" file and some data exist in the force field
for the "CB" atom type with each particular property. This dialog helps to update
quickly any parameters to be used to create the "FIELD" file:

Figure 7.16 Updating parameters for the "FIELD" file, using field parameters for the "CB"
atom(s) in the "Amber 99" force field.

As illustrated in figure 7.16 to update any "FIELD" file value simply browse the property
tree, select the desired force field parameters among available data, remember to check
the "update" button at the end of the line, and finally pressed the "Apply" button.
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"Core-shell unit(s)"

Figure 7.17 "Core-shell unit(s)" tab in the "DL-POLY" assistant.

133



Preparing molecular dynamics calculations in atomes 134

"Constraint bond(s)"

Figure 7.18 "Constrains bond(s)" tab in the "DL-POLY" assistant.
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"Mean force potential(s)"

Figure 7.19 "Mean force potential(s)" tab in the "DL-POLY" assistant.
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"Rigid unit(s)"

Figure 7.20 "Rigid unit(s)" tab in the "DL-POLY" assistant.
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"Tethering potential(s)"

Figure 7.21 "Tethering potential(s)" tab in the "DL-POLY" assistant.

137



Preparing molecular dynamics calculations in atomes 138

"Flexible chemical bond(s)" and "Bond restraint(s)"

The tabs for the "Flexible chemical bond(s)" and the "Bond restraint(s)" being
extremely similar, this manual presents only the part related to "Flexible chemical
bond(s)".
As illustrated in figure 7.22 the bonds, for the selected molecule, are listed by type
depending on the nature of the field atoms involved, also for each type of bond it is
possible to display every single bond in the molecule.

Figure 7.22 "Flexible chemical bond(s)" tab in the "DL-POLY" assistant.
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Each line corresponds to a either to a bond type, or a particular bond, for the molecule
specified above, and for each bond the information is as follow:

1. ID in the molecule (if the line refers to a bond type).

2. Name for atom type 1 (bond type), or field number for atom 1 (bond).

3. Name for atom type 2 (bond type), or field number for atom 2 (bond).

4. Value measured in the model: average for all bonds for that type, or, value (or
average if the multiplicity for the molecule is > 1) for that particular bond.

5. Visualize all bonds of that type or that particular bond in the model.

6. Use to create the "FIELD" file, if not checked the bond / type will not be used.

7. Potential to use to describe all bonds of that type ("Default:" value) or that
particular bond in the model.

8. Numerical value(s) for the parameters of the selected potential.

The description of the bond(s) can be modified simultaneously for all bond(s) of the
same type using the root line that type, or one by one by browsing the list and picking
any line. It is therefore possible to choose a different parametrization for every single
bond in the molecule. Some parameters can be modified directly in the table, otherwise
a simple double click using the mouse left button will open the bond edition dialog
illustrated in figure 7.23.

Figure 7.23 "Flexible chemical bond(s)" edition dialog in the "DL-POLY" assistant.
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In figure 7.23 the "Field parameters" combo box presents the list of matching param-
eters, chemical species wise, found in the force field selected at the initialization stage.

The next tabs of the assistant dedicated to intra-molecular properties are as follow:

• "Bond angle(s)"

• "Angular restraint(s)"

• "Dihedral angle(s)"

• "Torsional restraint(s)"

• "Improper angle(s)"

• "Inversion angle(s)"

For all these properties the philosophy is similar to the one presented above for the
"Flexible chemical bond(s)". Hence will only briefly illustrate the different tabs
without more details.

"Bond angle(s)" and "Angular restraint(s)"

Figure 7.24 "Bond angle(s)" tab in the "DL-POLY" assistant.
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"Dihedral angle(s)" and "Torsional restraint(s)"

Figure 7.25 "Dihedral angle(s)" tab in the "DL-POLY" assistant.

"Improper angle(s)"

Figure 7.26 "Improper angle(s)" tab in the "DL-POLY" assistant.
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"Inversion angle(s)"

Figure 7.27 "Inversion angle(s)" tab in the "DL-POLY" assistant.
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"van der Waals potential(s)"

Figure 7.28 "van der Waals potential(s)" tab in the "DL-POLY" assistant.
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"Metal potential(s)"

Figure 7.29 "Metal potential(s)" tab in the "DL-POLY" assistant.
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"Tersoff potential(s)"

Figure 7.30 "Tersoff potential(s)" tab in the "DL-POLY" assistant.
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"Three body potential(s)"

Figure 7.31 "Three potential(s)" tab in the "DL-POLY" assistant.
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"Four body potential(s)"

Figure 7.32 "Four body potential(s)" tab in the "DL-POLY" assistant.
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"External field(s)"

Figure 7.33 "External field(s)" tab in the "DL-POLY" assistant.
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7.1.1.4 "Preview"

At any time when using the "DL-POLY" assistant, the "Preview" button allows open
the "DL-POLY files preview" dialog, to visualize the "CONTROL", "FIELD" and "CONFIG"
file(s).

Figure 7.34 "DL-POLY files preview" dialog in the "DL-POLY" assistant.

The "DL-POLY files preview" dialog (fig. 7.34) contains a notebook with up to 3 tabs
depending on the file(s) to be created. Each tab presents the content of a file, "CONTROL",
"FIELD" or "CONFIG", and highlights option(s) and keyword(s) using color(s) and font
layout option(s).

7.1.1.5 Finalizing the assistant and file(s) creation

When pressing the "Apply" button on the file tab of the assistant, the user is asked to
selected a folder. "CONTROL", "FIELD" and "CONFIG" if selected, will be created in the
selected directory.

Following the file(s) creation or if the assistant is closed anyway, the "DL-POLY" force
field data will be preserved. Therefore allowing the re-open the assistant later for
further modifications.

All existing force field data can also saved in the atomes project and/or workspace files,
simply remember to save your work.
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7.1.2 LAMMPS

Coming soon
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7.2 Ab-initio MD

7.2.1 CPMD v4.3.0

The atomes helper for the CPMD calculation offers to prepare input files for
CPMD v4.3.0. Please note that the CPMD code offers so many calculation options
that it is not possible either to provide a description or to offer a comprehensive usage
guide for each of these options. Therefore the CPMD calculation assistant only pro-
vides help towards basics and / or frequently used calculation options.

In any case if you intent to use the CPMD code please refer to the user manual:

https://www.cpmd.org/wordpress/CPMD/getFile.php?file=manual.pdf

The atomes helper for the CPMD calculation provides a step by step interface to con-
figure the different sections of the CPMD input file:

The "INFO" section

Figure 7.35 "INFO section" tab in the "CPMD" assistant.
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The "CPMD" section

The creation of the "CPMD" section is split over 3 tabs, dedicated respectively to the
calculation, thermostat and restart option(s).

"Calculation options"

The "Calculation to be performed" [Fig. 7.36] combo allows to select the type of job:

Figure 7.36 "CPMD section - Calculation options" tab in the "CPMD" assistant.

The option(s) directly bellow the combo will change depending on the nature of the
calculation, please refer to the CPMD user manual for more information on theses
options.
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"Thermostat options"

If a molecular dynamics calculation is to be performed then the "CPMD section -
Thermostat options" tab becomes accessible:

Figure 7.37 "CPMD section - Thermostat options" tab in the "CPMD" assistant.

In order to access the next page of the assistant thermostat(s) must be set up properly.
Again for more information please refer to the CPMD user manual.

"RESTART options"

The "CPMD section - Restart options" tab present options to restart calculation and
saving options during the calculation:

Figure 7.38 "CPMD section - Restart options" tab in the "CPMD" assistant.
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The "DFT" section

Figure 7.39 "DFT section" tab in the "CPMD" assistant.

The "VDW" section

Figure 7.40 "VDW section" tab in the "CPMD" assistant.

Providing that van der Waals interactions are selected in the "CPMD" section of the
input file, then the "VDW" section becomes accessible. However its content is filled
automatically based on parameters selected in both the "CPMD" and "DFT" sections.
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The "PROP" section

Figure 7.41 "PROP section" tab in the "CPMD" assistant.

Providing that the "Calculation of physical properties" is selected in the "CPMD"
section of the input file, then the "PROP" section becomes accessible. However its content
is filled automatically based on parameters selected in the "CPMD" section.

The "SYSTEM" section

Figure 7.42 "SYSTEM section" tab in the "CPMD" assistant.
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The "ATOMS" section

Figure 7.43 "ATOMS section" tab in the "CPMD" assistant.
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7.2.2 CP2K v9.1

The atomes helper for the CP2K calculation offers to prepare input files for CP2K v9.1.
Please note that the CP2K code offers so many calculation options that it is not possible
either to provide a description or to offer a comprehensive usage guide for each of these
options. Therefore the CP2K calculation assistant only provides help towards basics
and / or frequently used calculation ab-initio options.

In any case if you intent to use the CP2K code please refer to the user manual:

https://www.cp2k.org/howto

The atomes helper for the CP2K calculation provides a step by step interface to configure
the different sections of the CP2K input file(s) for ab-initio calculations:

The "CP2K input structure" section

The CP2K input can be rather initimidating, you can decide at this stage either to
have all input data gathered in a single file, or alternatively split in several, content
orientated, files:

The "GLOBAL" section

Select the calculation to be performed, and some general options regarding the process.
Note that atomes provides, when available, basis set(s) and pseudo-potential(s) from
the CP2K database. Basis set(s) and pseudopotential(s) will be saved respectivelly in
"basis.inc" and "pseudo.inc".

The "FORCE_EVAL" section

Describe the details of the forces evaluation process.

The "SUBSYS" section

The "MOTION" section

7.3 Quantum Mechanics and Molecular Mechanics MD

7.3.1 CPMD

Coming soon

7.3.2 CP2K

Coming soon
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Supported atomic coordinates file
formats

The current version of atomes can import atomic coordinates in the following formats:

− XYZ [30] ∗

− Chem3D [31]

− CPMD trajectory [3] ∗ ∗∗

− VASP trajectory [32] ∗ ∗∗∗

− ISAACS Project File [33]

− PDB/ENT (Protein Data Bank) v3.30

− CIF (Crystallographic information)

− DL-POLY History file ∗

Table A.1 Atomic coordinates file formats read by atomes.

∗ including NPT trajectories.
∗∗ atomic units are assumed in the case of CPMD trajectories.
∗∗ and ∗∗∗ require to enter extra parameters through an interactive dialog box:

• Total number of atoms

• Number of chemical species

• Label and number of each atomic species

the input order, label and number of each atomic species will be the one assumed when
reading the coordinates from the trajectory file.
atomes can also export atomic coordinates in XYZ or Chem3D format.
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Keyboard shortcuts and command line
options

B.1 Keyboard shortcuts

• Main window

– Workspace:

Ctrl + w : open workspace

Ctrl + s : save workspace as

Ctrl + c : close workspace

– Project:

Ctrl + n : create new project

Ctrl + o : open project

– Misc:

Ctrl + t : show curve toolboxes

Ctrl + p : open periodic table

Ctrl + a : show about dialog

Ctrl + q : quit
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• Curve window:

Ctrl + a : Autoscale

Ctrl + c : Close curve window

Ctrl + e : Open the data plot editing tool box [Fig. 4.6]

Ctrl + i : Export image

Ctrl + s : Save / export data

• OpenGL window:

– Single key shortcuts:

* Colors:

a : change atom(s) colormap
p : change polyhedra(ons) colormap

* Styles:

b : change default style to "Ball and stick"
c : change default style to "Cylinders"
d : change default style to "Dots"
s : change default style to "Spheres"
o : change default style to "Covalent radius"
i : change default style to "Ionic radius"
v : change default style to "van Der Waals radius"
r : change default style to "In cristal radius"
w : change default style to "Wireframe"

* Measures:

m : show all measures for the selection, if pressed:

· once: display inter-atomic distance(s)
· twice: display inter-atomic angles
· a third time: hide measures

* Misc:

VI
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Esc : exit fullscreen mode

: pause / restart spinning

– Combined keys shortcuts:

* Mouse mode:

Alt + a : enter mouse "Analysis" mode

Alt + e : enter mouse "Edition" mode

* Selection:

Ctrl + a : select / unselect all atoms

Ctrl + c : copy all selected atom(s)

Ctrl + n : create new (empty project)

* Misc:

Ctrl + l : label / unlabel all atoms

Ctrl + e : "Environments configuration" window [Sec. 5.1.3]

Ctrl + m : "Measures" dialog [Sec. 5.1.4]

Ctrl + r : "Recorder" dialog [Sec. 5.1.6]

Ctrl + f : enter / exit fullscreen mode

* Camera motion:

Shift ⇑ + ↑ : zoom out

Shift ⇑ + ↓ : zoom in

• OpenGL window Analysis mode only

– Single key shortcuts:

* Model rotation:

→ : rotate right

← : rotate left

↑ : rotate up

↓ : rotate down
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– Combined keys shortcuts:

* Camera motion:

Ctrl + → : move camera right

Ctrl + ← : move camera left

Ctrl + ↑ : move camera up

Ctrl + ↓ : move camera down

* Spinning:

Ctrl + Shift ⇑ + → : spin right / increase speed r. or reduce speed left

Ctrl + Shift ⇑ + → : spin left / increase speed left or reduce speed
right

Ctrl + Shift ⇑ + ↑ : spin up / increase speed up or reduce speed down

Ctrl + Shift ⇑ + ↓ : spin down / increase speed d. or reduce speed up

Ctrl + s : stop spinning

• OpenGL window: Edition mode only

– Single key shortcuts:

* Atomic coordinates rotation:

→ : rotate atomic coordinates right

← : rotate atomic coordinates left

↑ : rotate atomic coordinates up

↓ : rotate atomic coordinates down

– Combined keys shortcuts:

* Atomic coordinates translation:

Ctrl + → : translate atomic coordinates right

Ctrl + ← : translate atomic coordinates left

Ctrl + ↑ : translate atomic coordinates up

Ctrl + ↓ : translate atomic coordinates down
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B.2 Command line options

atomes can be used from the command line, including using the following options:

• General options:

"-h" or "�help": short help.

"-v" or "�version": version information.

• File options:

"-awf filename": open atomes workspace file.

"-apf filename": open atomes project file.

"-xyz filename": open coordinates in XYZ format [30].

"-pdb filename": open coordinates in PDB format.

"-ent filename": open coordinates in PDB format.

"-c3d filename": open coordinates in Chem3D format [31].

"-cif filename": open coordinates in CIF format.

"-trj filename": open CPMD trajectory [3].

"-xdatcar filename": open VASP trajectory [32].

"-hist filename": open DL_POLY history trajectory [1].

"-ipf filename": open ISAACS project file [33].

1. If no file option(s) is (are) provided then atomes will try to open the file(s) based
on its (their) extension(s) (ex: a file which name end by ".xyz" will be assumed to
follow the XYZ structure).

2. The structure of "filename" is expected to follow the structure introduced with
the option (ex: "-xyz" for a file that contains coordinates in the XYZ format), but
"filename" is not required to have the corresponding extention (ex: ".xyz").

3. Since atomes has a single workspace only a single workspace file can be opened
via the command line.

• Examples:

Open all PDB files in the active directory:

user@localhost ~]$ atomes *.pdb

Open a workspace file, and other coordinates files:

user@localhost ~]$ atomes -pdb this.f file.awf -cif that.f *.xyz
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atomes will parse the command line, detect that a workspace file "file.awf" is to be
opened and will open it first.
Then the other coordinate files will be opened and added to the workspace:

• As enforced by the "-pdb" option, "this.f" is supposed to follow the PDB format.

• As enforced by the "-cif" option, "that.f" is supposed to follow the CIF format.

• All files with the ".xyz" extension in the directory will be opened assuming that
they follow the XYZ format.

X



The "Library" in atomes

The atomes program includes a library with a number of molecules to be used when
building or editing atomistic models:

Figure C.1 The "Library" dialog of the atomes program.

Available molecules can be found in the library by sorted in the following families:

• Misc

• Alcohols

• Aldehydes

• Alkanes

• Alkenes

• Alkynes

• Amides

• Amines

• Amino acids

• Aromatics

• Carboxylic acids

• Cyclic alkanes

• Cyclic alkenes

• Ethers

• Fatty acids

• Fullerenes

• Heterocyclics

• Macrocycles

• Ketones

• Nitriles

• Nucleobases

• Steroids

• Sugars (Linears)

• Sugars (Cyclics)

• Sulfoxides

• Thiols
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Each time a new molecule is selected in the tree view on the left side of the window
(see figure C.1), then the right side of the "Library" dialog is refreshed with the data
of the newly selected molecule. The data includes a 3D representation included in an
active OpenGL window that allows to rotate the molecule:

Figure C.2 Using the "Library" dialog.

The data files that contain the information regarding each molecule in the library are
located in the "bin/library/molecules" directory.
To each molecule that appears in the "Library" tree view, a file with the ".sml" extension
can be found in the corresponding family subfolder.
For the example in figure C.2:

• The family is: "Aromatics"

• The molecule is: "Caffeine"

• The corresponding file is: "Aromatics/caffeine.sml".

New files can be added to the library to be found by atomes at startup, providing that
the new files are added to one of the families of the library. These files must have the
".sml" extension, follow the "XML" encoding rules, and the following structure:
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The "SCL" "Simple chemical library XML file" format

<?xml version="1.0" encoding="UTF-8"?>

<!-- Simple chemical library XML file -->

<scl-xml>

<class>Aromatics</class>

<names>

<library-name>Caffeine</library-name>

<iupac-name>Caffeine</iupac-name>

<other-names>

<name>Guaranine</name>

<name>Theine</name>

<name>Trimethylxanthine</name>

<name>1,3,7-Trimethyl-1H-purine-2,6(3H,7H)-dione</name>

</other-names>

</names>

<chemistry>

<atoms>24</atoms>

<species number="4">

<label id="0" num="8">C</label>

<label id="1" num="10">H</label>

<label id="2" num="2">O</label>

<label id="3" num="4">N</label>

</species>

</chemistry>

<coordinates>

<atom id="1" sp="0" x="1.785021" y="-0.779129" z="-0.255949"/>

<atom id="2" sp="0" x="0.401929" y="1.318216" z="-0.016004"/>

<atom id="3" sp="0" x="-0.733464" y="0.413478" z="0.038347"/>

<atom id="4" sp="0" x="-0.617909" y="-0.973998" z="-0.109571"/>

<atom id="5" sp="0" x="-2.772439" y="-0.562269" z="0.209813"/>

<atom id="6" sp="0" x="0.735608" y="-3.069196" z="-0.210904"/>

<atom id="7" sp="0" x="-2.730788" y="1.961282" z="0.459758"/>

<atom id="8" sp="0" x="2.908891" y="1.458603" z="-0.240195"/>

<atom id="9" sp="1" x="-3.848274" y="-0.720508" z="0.332764"/>

<atom id="10" sp="1" x="1.561100" y="-3.446348" z="-0.829847"/>

<atom id="11" sp="1" x="-0.192018" y="-3.562176" z="-0.530166"/>

<atom id="12" sp="1" x="0.935512" y="-3.340819" z="0.835372"/>

<atom id="13" sp="1" x="-2.333498" y="2.706064" z="-0.245137"/>

<atom id="14" sp="1" x="-2.525360" y="2.320312" z="1.478733"/>

<atom id="15" sp="1" x="-3.818507" y="1.892617" z="0.326144"/>

<atom id="16" sp="1" x="3.674681" y="0.991531" z="-0.874770"/>

<atom id="17" sp="1" x="3.303682" y="1.537341" z="0.782105"/>

<atom id="18" sp="1" x="2.721889" y="2.471199" z="-0.622647"/>

<atom id="19" sp="2" x="2.892437" y="-1.297551" z="-0.212698"/>

<atom id="20" sp="2" x="0.363733" y="2.532611" z="0.115710"/>

<atom id="21" sp="3" x="1.659632" y="0.660920" z="-0.271271"/>

<atom id="22" sp="3" x="0.612806" y="-1.608906" z="-0.393730"/>

<atom id="23" sp="3" x="-2.109760" y="0.657267" z="0.234906"/>

<atom id="24" sp="3" x="-1.874903" y="-1.560540" z="-0.000764"/>

</coordinates>

</scl-xml>

Table C.1 Example of "sml" file in XML format for caffeine.
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Crystal building in atomes

The crystal building process in atomes will be briefly presented in the next pages. 2
example cases will be used to illustrate the methodology implemented in the program:

1. The Fd3̄m space group, N◦227, with the first setting: origin 1.

2. The R3̄c space group, N◦167, with the second setting: rhombohedral parameters.

The terminology used in the atomes program, and therefore used in this manual, is
directly taken from the International tables for Crystallography Vol. A. [29]
In the following every single step depends on the considered space group, and corre-
sponds to the way the process is implemented in atomes:

1. Determine the origin of the coordinate system.

2. Calculate the inverse transformation matrix.

3. Select the space group extra site positions, if any.

4. Adjust the different symmetrical positions of the first Wyckoff position using 2.

5. Calculate the crystalline positions using 4 and 3.

6. Select the unique position(s) in 5 to build the crystal.

7. Calculate the object position in Cartesian coordinates using 6.

8. Insert object(s) at the appropriate coordinates based on occupancy.

Origin of the coordinate system

The origin of the coordinate system, if any particular, determine how the object frac-
tional coordinates are modified to match the space group criteria before calculating the
Cartesian coordinates.
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The first step is to build the 4×3 matrix that describe the operation of be performed,
the required information is given by the space group setting, the easiest way to use it
is on the form of the transformation matrix P:
Ex: (a, b, c) and can be converted in:





1 0 0 0
0 1 0 0
0 0 1 0




(D.1)

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:

(a-1
8 , b-1

8 , c-1
8) (2

3a+1
3b+1

3c, −1
3a+1

3b+1
3c, −1

3a-2
3b+1

3c)

The corresponding P matrix are:




1 0 0 −1
8

0 1 0 −1
8

0 0 1 −1
8









2
3 −

1
3 −

1
3 0

1
3

1
3 −

2
3 0

1
3

1
3

1
3 0





Inverse transformation matrix

To transform the coordinates to the appropriate system we use the corresponding
inverse matrix P−1:

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:




1 0 0 −1
8

0 1 0 −1
8

0 0 1 −1
8









1 0 1 0
−1 1 1 0

0 −1 1 0





The P−1 matrix allows to easily compute the coordinates (x′, y′,z′) of a point (x, y,z) in
the appropriate coordinate system using:

(x′, y′,z′) = P−1× (x, y,z) (D.2)
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Space group extra site position(s)

The space group extra site position(s) describe translations to be performed on the
initial set of Wyckoff position to get the entire list of coordinates.
The list of extra position(s), E(ex,ey,ez), is imported from the space group data file, and
is presented on top the Wyckoff positions table of the space group info window:

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:

+(0,0,0)+ (0, 1
2 ,

1
2 )+ (1

2 ,0,
1
2 )+ (1

2 ,
1
2 ,0) +(0,0,0)+ (0,0,0)+ (0,0,0)

Symmetrical positions using the first Wyckoff position

The first step is to convert the list of coordinates from the first Wyckoff position on the
form of matrix W:

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:

(x, y, z) (x, y, z)




1 0 0 0
0 1 0 0
0 0 1 0









1 0 0 0
0 1 0 0
0 0 1 0





The W’ matrix, suitable for the calculation, is calculated using the P−1 matrix for the
corresponding space group:

W′ =W×P−1 (D.3)

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:




1 0 0 −1
8

0 1 0 −1
8

0 0 1 −1
8









1 1 0 0
−1 1 1 0

0 −1 1 0





The results, converted back to standard coordinates, are presented in the Wyckoff po-
sitions table of the space group info window:

(1) Fd3̄m space group, N◦227, origin 1: (2) R3̄c space group, N◦167, second setting:

(x− 1
8 , y−

1
8 ,z−

1
8 ) (x+ z,−x+ y+ z,−y+ z)

. . . . . .

Object position(s)

The first step in getting the final fractional coordinates F( fx, fy, fz) of an object to insert
with fractional coordinates given at input O(ox,oy,oz) is to convert its coordinates to the
proper coordinates system O′(o′x,o′y,o′z):

O′(o′x,o
′
y,o
′
z) = P×O(ox,oy,oz) (D.4)
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Then for a particular Wyckoff position W’ and extra site position E(x, y,z), the final
fractional coordinates F( fx, fy, fz) are calculated by:

F( fx, fy, fz) = E(ex,ey,ez)+W′×O′(o′x,o
′
y,o
′
z) (D.5)

Removing duplicate position(s)

Since one of the goal in atomes is to build crystal structure of super-structure to
work with, all crystalline positions cannot be conserved and duplicate positions (same
positions using the periodic boundary conditions) must be removed.
When final positions F( fx, fy, fz) are calculated duplicates are removed on the fly. The
first final position with a unique set of coordinates F( fx, fy, fz) is preserved while the
others will be ignored. Duplicates are identical set of atomic coordinates, that can be
found because of the symmetrical properties of the space group.
In atomes a duplicate position Fb(bx,by,bz) will be removed if Fa(ax,ay,az) has already
been found and providing that:

[

ax = bx or abs(ax−bx) = n,n integer
]

and
[

ay = by or abs(ay−by) = n,n integer
]

and
[

az = bz or abs(az−bz) = n,n integer
]

Calculate the object final position(s) in Cartesian coordi-

nates

After the construction/selection process Cartesian coordinates C(cx,cy,cz) of an object
with fractional coordinates F( fx, fy, fz) are calculated using:

C(cx,cy,cz) = FtC×F( fx, fy, fz) (D.6)

with FtC the fractional to Cartesian conversion matrix is defined by:





a bcosγ ccosβ
0 bsinγ cω
0 0 Ω

absinγ




(D.7)

where ω and Ω are respectively:

ω =
cosα− cosβcosγ

sinγ
(D.8)

and:
Ω= abc

√

1− cos2α− cos2β− cos2γ+2cosαcosβcosγ (D.9)

a, b, c and α, β, γ are the lattice parameters provided at input.
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Occupancy

The only thing left to do after that it to select which set of coordinates are to be occupied
among the list prepared in the previous steps. Depending on the occupancy defined at
input atomes does the following:

• If the occupancy is equal to 1.0: all coordinates are to be occupied and no particular
selection is performed.

• If the occupancy is < 1.0, then the following options are possible to handle occu-
pancy:

1. "Random for the initial cell only": sites are filled randomly in the ini-
tial cell only, then the initial cell is simply replicated.

2. "Random cell by cell": sites are filled randomly for each cell, cell by cell
separately.

3. "Completely random": sites are filled randomly for the entire network, the
final crystal is considered as whole.

4. "Successively": sites are filled successively, all object(s) A are inserted (for
the first n(A) positions), then all object(s) B are inserted (for the next n(B)
positions) ...

5. "Alternatively": sites are filled alternatively: object A is inserted on the
first position, object B is inserted on the second position, object A on the
third position, object B on the fourth position ... and so on.

For 1, 2, 4 and 5 the number of object(s) by cell is constant, but it can vary for 3.
For 4 and 5 the order of the positions to be filled is the order they are found in
during the previous steps.

Final check: distance(s) between inserted objects

Finally the last calculation performed by atomes when creating the crystal is distance
check between the object(s) be inserted. Note that this check performed, if and only if,
no overlapping is allowed.
If any distance dab between 2 objects a and b, is found to be too small the following can
happen:

1. If dab < 0.5 Å then a warning message will pop-up and ask for the user confirmation
to continue, or not, to build the crystal.

2. If the user decides to build the crystal anyway and if dab = 0.0 then for fail safe
reasons object b is removed from the list to build.

The "SGL" "Space group info XML file" format

The data files that contain the information regarding each of the 230 space groups are
located in the "bin/library/space_groups" directory.
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In this folder to each space group corresponds a file with a name following the con-
struction:

"space group number"-"space group name"."sgl"

For the Fd3̄m space group, the corresponding file is "227-Fd-3m.sgl".
These files must have the ".sgl" extension, follow the "XML" encoding rules, and the
following structure:

<?xml version="1.0" encoding="UTF-8"?>

<!-- Space group info XML file -->

<sg-xml>

<space-group>R-3c</space-group>

<sg-num>167</sg-num>

<hm-symbol>R -3 2/c</hm-symbol>

<bravais>Trigonal</bravais>

<settings num="2">

<set name="R_-3_c_:h" x="a" y="b" z="c">

<points num="3">

<pt x="0" y="0" z="0"/>

<pt x="2/3" y="1/3" z="1/3"/>

<pt x="1/3" y="2/3" z="2/3"/>

</points>

</set>

<set name="R_-3_c_:r" x="2/3a+1/3b+1/3c" y="-1/3a+1/3b+1/3c" z="-1/3a-2/3b+1/3c">

<points num="3">

<pt x="0" y="0" z="0"/>

<pt x="0" y="0" z="0"/>

<pt x="0" y="0" z="0"/>

</points>

</set>

</settings>

<wyckoff num="6">

<wyck id="1" mul="12" let="f" site="1">

<pos x="x" y="y" z="z"/>

<pos x="-y" y="x-y" z="z"/>

<pos x="-x+y" y="-x" z="z"/>

<pos x="y" y="x" z="-z+1/2"/>

<pos x="x-y" y="-y" z="-z+1/2"/>

<pos x="-x" y="-x+y" z="-z+1/2"/>

<pos x="-x" y="-y" z="-z"/>

<pos x="y" y="-x+y" z="-z"/>

<pos x="x-y" y="x" z="-z"/>

<pos x="-y" y="-x" z="z+1/2"/>

<pos x="-x+y" y="y" z="z+1/2"/>

<pos x="x" y="x-y" z="z+1/2"/>

</wyck>

<wyck id="2" mul="6" let="e" site=".2">

<pos x="x" y="0" z="1/4"/>

<pos x="0" y="x" z="1/4"/>

<pos x="-x" y="-x" z="1/4"/>

<pos x="-x" y="0" z="3/4"/>

<pos x="0" y="-x" z="3/4"/>

<pos x="x" y="x" z="3/4"/>

</wyck>

<wyck id="3" mul="6" let="d" site="-1">

<pos x="1/2" y="0" z="0"/>

<pos x="0" y="1/2" z="0"/>

<pos x="1/2" y="1/2" z="0"/>

<pos x="0" y="1/2" z="1/2"/>

<pos x="1/2" y="0" z="1/2"/>

<pos x="1/2" y="1/2" z="1/2"/>

</wyck>

<wyck id="4" mul="4" let="c" site="3.">

<pos x="0" y="0" z="z"/>

<pos x="0" y="0" z="-z+1/2"/>

<pos x="0" y="0" z="-z"/>

<pos x="0" y="0" z="z+1/2"/>

</wyck>

<wyck id="5" mul="2" let="b" site="-3.">

<pos x="0" y="0" z="0"/>

<pos x="0" y="0" z="1/2"/>

</wyck>

<wyck id="6" mul="2" let="a" site="32">

<pos x="0" y="0" z="1/4"/>

<pos x="0" y="0" z="3/4"/>

</wyck>

</wyckoff>

</sg-xml>

Table D.1 Example of the "167-R-3c.sgl" file in XML format for the R3̄c space group.

XX



The physics in atomes

E.1 The periodic boundary conditions

Taking into account the finite size of model/simulation box is crucial to compute cor-
rectly many of the structural characteristics (e.g. ring statistics) of the system being
studied.
The importance of the finite size of model box can be illustrated using a 1 dm3 edged
cube of water (1 L) at room temperature. This cube contains approximately 3.3× 1025

water molecules, each of them can be considered as a sphere having a diameter of 2.8 Å.
Following this scheme surface interactions can affect up to 10 layers of spheres (water
molecules) far from the surface of the model cubic box. In this case the number of water
molecules exposed to the surface is about 2×1019, which is a small fraction of the total
number of molecules in the model.
Currently structure models often contain somewhere from 1 thousand to several thou-
sands of molecules/atoms. As a result a very substantial fraction of them will be
influenced by the finite size of the simulation/model box. The problems is solved by
applying the so-called Periodic Boundary Conditions "PBC" which means surrounding
the simulation box with its translational images in the 3 directions of space, as illus-
trated below.

Users of atomes should take special care that their model boxes are inherently periodic
so that when the periodic boundary conditions are applied the structural characteristics
computed are not compromised.
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Figure E.1 Schematic representation of the idea of periodic boundary conditions.

Figure E.1 illustrates the principle of the periodic boundary conditions that can be
used1 in atomes: a particle which goes out from the simulation box by one side is
reintroduced in the box by the opposite side (in the 3 dimensions of space).

When PBC are used the maximum inter-atomic distance rmax which is taken into account
in the calculations, depends on the lattice parameters:

rmax ≃
L×
√

3
2

with L = box size (E.1)

The surface/finite model size effects would therefore be small, if any. In general, the
larger the simulation box and the number of molecules/atoms in it, the smaller the
surface/size effects will be.

1Please note that the use of PBC is not mandatory, isolated molecules can be studied using atomes
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XXIII E.2. Radial distribution functions

E.2 Radial distribution functions

The Radial Distribution Function, R.D.F. , g(r), also called pair distribution function or
pair correlation function, is an important structural characteristic, therefore computed
by atomes.

Figure E.2 Space discretization for the evaluation of the radial distribution function.

Considering a homogeneous distribution of the atoms/molecules in space, the g(r)
represents the probability to find an atom in a shell dr at the distance r of another atom
chosen as a reference point [Fig. E.2]. By dividing the physical space/model volume
into shells dr [Fig. E.2] it is possible to compute the number of atoms dn(r) at a distance
between r and r+dr from a given atom:

dn(r) =
N

V
g(r) 4π r2 dr (E.2)

where N represents the total number of atoms, V the model volume and where g(r) is
the radial distribution function. In this notation the volume of the shell of thickness dr
is approximated:

(

Vshell =
4
3
π(r+dr)3 − 4

3
πr3 ≃ 4π r2 dr

)

(E.3)

When more than one chemical species are present the so-called partial radial distribu-
tion functions gαβ(r) may be computed :

gαβ(r) =
dnαβ(r)

4πr2 dr ρα
with ρα =

Nα

V
=

N× cα
V

(E.4)

where cα represents the concentration of atomic species α.
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These functions give the density probability for an atom of the α species to have a
neighbor of the β species at a given distance r. The example features GeS2 glass.
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Figure E.3 Partial radial distribution functions of glassy GeS2 at 300 K.

Figure E.3 shows the partial radial distribution functions for GeS2 glass at 300 K. The
total RDF of a system is a weighted sum of the respective partial RDFs, with the weights
depend on the relative concentration and x-ray/neutron scattering amplitudes of the
chemical species involved.
It is also possible to use the reduced Gαβ(r) partial distribution functions defined as:

Gαβ(r) = 4πrρ0
(

gαβ(r) −1
)

(E.5)

atomes gives access to:

• The partial gαβ(r) and Gαβ(r) distribution functions, and more see [Eq.E.14].

• The corresponding dnαβ(r) integrated number of neighbors.

Also two methods are available to compute the radial distribution functions:

• The standard real space calculation typical to analyze 3-dimensional models

• The experiment-like calculation using the Fourier transform of the structure factor
obtained using the Debye equation (see section E.3 for details).
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E.3 Neutrons and X-rays scattering

Model static structure factors S(q) may be compared to experimental scattering data
and that is why are useful structural characteristics computed by atomesThereafter we
describe the theoretical background of S(q)s computed by atomes

E.3.1 Total scattering - Debye approach

Neutron or X-ray scattering static structure factor S(q) is defined as:

S(q) =
1
N

∑

j,k

b j bk

〈

eiq[r j− rk]
〉

(E.6)

where b j and r j represent respectively the neutron or X-ray scattering length, and the
position of the atom j. N is the total number of atoms in the system studied.
To take into account the inherent/volume averaging of scattering experiments it is
necessary to sum all possible orientations of the wave vector q compared to the vector
r j − rk. This average on the orientations of the q vector leads to the famous Debye’s
equation:

S(q) =
1
N

∑

j,k

b j bk

sin(q|r j− rk|)
q|r j− rk|

(E.7)

Nevertheless the instantaneous individual atomic contributions introduced by this
equation E.7 are not easy to interpret. It is more interesting to express these contribu-
tions using the formalism of radial distribution functions [Sec. E.2].
In order to achieve this goal it is first necessary to split the self-atomic contribution
( j = k), from the contribution between distinct atoms:

S(q) =
∑

j

c jb
2
j +

1
N

∑

j,k

b j bk

sin(q|r j− rk|)
q|r j− rk|

︸                       ︷︷                       ︸

I(q)

with c j =
N j

N
(E.8)

where 4π
∑

j c jb
2
j

represents the total scattering cross section of the material.
The function I(q) which describes the interaction between distinct atoms is related to
the radial distribution functions through a Fourier transformation:

I(q) = 4πρ
∫ ∞

0
dr r2 sinqr

qr
G(r) (E.9)

where the function G(r) is defined using the partial radial distribution functions
[Eq. E.4]:

G(r) =
∑

α,β

cαbα cβbβ (gαβ(r)−1) (E.10)

where cα =
Nα

N
and bα represents the neutron or X-ray scattering length of species α.

G(r) approaches - −
∑

α,β

cαbα cβbβ for r = 0, and 0 for r→∞.
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Usually the self-contributions are subtracted from equation E.8 and the structure factor
is normalized using the relation:

S(q) − 1 =
I(q)

〈b2〉
with 〈b2〉 =





∑

α

cαbα





2

(E.11)

It is therefore possible to write the structure factor [Eq. E.7] in a more standard way:

S(q) = 1 + 4πρ
∫ ∞

0
dr r2 sinqr

qr
(g(r)−1) (E.12)

where g(r) (the radial distribution function) is defined as:

g(r) =

∑

α,β

cαbα cβbβ gαβ(r)

〈b2〉
(E.13)

In the case of a single atomic species system the normalization allows to obtain values
of S(q) and g(r) which are independent of the scattering factor/length and therefore
independent of the measurement technique. In most cases, however, the total S(q) and
g(r) are combinations of the partial functions weighted using the scattering factor and
therefore depend on the measurement technique (Neutron, X-rays ...) used or simu-
lated.
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Figure E.4 Total neutron structure factor for glassy GeS2 at 300 K - A Evaluation using the
atomic correlations [Eq. E.7], B Evaluation using the pair correlation functions
[Eq. E.12].

Figure E.4 presents a comparison between the calculations of the total neutron struc-
ture factor done using the Debye relation [Eq. E.7] and the pair correlation functions
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[Eq. E.12]. The material studied is a sample of glassy GeS2 at 300 K obtained using
ab-initio molecular dynamics. In several cases the structure factor S(q) and the radial
distribution function g(r) [Eq. E.13] can be compared to experimental data. To simplify
the comparison atomes computes several radial distribution functions used in practice
such as G(r) defined [Eq. E.10], the differential correlation function D(r), G(r), and the
total correlation function T(r) defined by:

D(r) = 4πrρ G(r) (E.14)

G(r) =
D(r)
〈b2〉

T(r) = D(r) + 4πrρ 〈b2〉

g(r) equals zero for r = 0 and approaches 1 for r→∞.
D(r) equals zero for r = 0 and approaches 0 for r→∞.
G(r) equals zero for r = 0 and approaches 0 for r→∞.
T(r) equals zero for r = 0 and approaches∞ for r→∞.

This set of functions for a model of GeS2 glass (at 300 K) obtained using ab-initio
molecular dynamics is presented in figure E.5.
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Figure E.5 Example of various distribution functions neutron-weighted in glassy GeS2 at
300 K.
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atomes can compute, for the case of x-rays and/or neutrons, the following functions:

• S(q) and Q(q) = q[S(q)−1.0] [12, 13] computed using the Debye equation

• S(q) and Q(q) = q[S(q)−1.0] [12, 13] computed using the Fourier transform of g(r)

• g(r), G(r), D(r) and T(r) computed using the standard real space calculation

• g(r), G(r), D(r) and T(r) computed using the Fourier transform of Debye S(q)

E.3.2 Partial structure factors

There are a few, somewhat different definitions of partials S(q) used in practice, and
computed by atomes

E.3.2.1 Faber-Ziman definition/formalism

One way used to define the partial structure factors has been proposed by Faber and
Ziman [14]. In this approach the structure factor is represented by the correlations
between the different chemical species. To describe the correlation between the α and
the β chemical species the partial structure factor SFZ

αβ (q) is defined by:

SFZ
αβ (q) = 1 + 4πρ

∫ ∞

0
dr r2 sinqr

qr

(

gαβ(r)−1
)

(E.15)

where the gαβ(r) are the partial radial distribution functions [Eq. E.4].
The total structure factor is then obtained by the relation:

S(q) =
∑

α,β

cαbα cβbβ
[

SFZ
αβ (q) − 1

]

(E.16)

E.3.2.2 Ashcroft-Langreth definition/formalism

In a similar approach, based on the correlation between the chemical species, and
developed by Ashcroft and Langreth [15, 16, 17], the partial structure factors SAL

αβ (q) are
defined by:

SAL
αβ (q) = δαβ + 4πρ

(

cαcβ
)1/2
∫ ∞

0
dr r2 sinqr

qr

(

gαβ(r)−1
)

(E.17)

where δαβ is the Kronecker delta, cα =
Nα

N
, and the gαβ(r) are the partial radial distribu-

tion functions [Eq. E.4].
Then the total structure factor can be calculated using:

S(q) =

∑

α,β

bαbβ
(

cαcβ
)1/2 [

SAL
αβ (q) + 1

]

∑

α

cαb2
α

(E.18)
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E.3.2.3 Bhatia-Thornton definition/formalism

In this approach, used in the case of binary systems ABx [18] only, the total structure
factor S(q) can be express as the weighted sum of 3 partial structure factors:

S(q) =
〈b〉2SNN(q)+2〈b〉(bA−bB)SNC(q)+ (bA−bB)2SCC(q)− (cAb2

A+ cBb2
B)

〈b〉2
+ 1 (E.19)

where 〈b〉= cAbA+cBbB, with cA and bA representing respectively the concentration and
the scattering length of species A.
SNN(q), SNC(q) and SCC(q) represent combinations of the partial structure factors calcu-
lated using the Faber-Ziman formalism and weighted using the concentrations of the
2 chemical species:

SNN(q) =
2∑

A=1

2∑

B=1

cAcBSFZ
AB(q) (E.20)

SNC(q) = cAcB×
[

cA×
(

SFZ
AA(q)−SFZ

AB(q)
)

− cB×
(

SFZ
BB(q)−SFZ

AB(q)
) ]

(E.21)

SCC(q) = cAcB×



1+ cAcB×





2∑

A=1

2∑

B,A

(

SFZ
AA(q)−SFZ

AB(q)
)








(E.22)

• SNN(q) is the Number-Number partial structure factor.
Its Fourier transform allows to obtain a global description of the structure of the
solid, ie. of the distribution of the experimental scattering centers, or atomic
nuclei, positions. The nature of the chemical species spread in the scattering
centers is not considered. Furthermore if bA = bB then SNN(q) = S(q).

• SCC(q) is the Concentration-Concentration partial structure factor.
Its Fourier transform allows to obtain an idea of the distribution of the chemical
species over the scattering centers described using the SNN(q). Therefore the
SCC(q) describes the chemical order in the material. In the case of an ideal binary
mixture of 2 chemical species A and B2, SCC(q) is constant and equal to cAcB. In the
case of an ordered chemical mixture (chemical species with distinct diameters,
and with heteropolar and homopolar chemical bonds) it is possible to link the
variations of the SCC(q) to the product of the concentrations of the 2 chemical
species of the mixture:

• SCC(q) = cAcB: random distribution.

• SCC(q) > cAcB: homopolar atomic correlations (A-A, B-B) preferred.

• SCC(q) < cAcB: heteropolar atomic correlations (A-B) preferred.

• 〈b〉 = 0: SCC(q) = S(q).
2Particles that can be described using spheres of the same diameter and occupying the same molar

volume, subject to the same thermal constrains, in a mixture where the substitution energy of a particle
by another is equal to zero.
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• SNC(q) is the Number-Concentration partial structure factor.
Its Fourier transform allows to obtain a correlation between the scattering centers
and their occupation by a given chemical species. The more the chemical species
related partial structure factors are different (SAA(q) , SBB(q)) and the more the
oscillations are important in the SNC(q). In the case of an ideal mixture SNC(q) = 0,
and all the information about the structure of the system is given by the SNN(q).

If we consider the binary mixture as an ionic mixture then it is possible to calculate the
Charge-Charge SZZ(q) and the Number-Charge SNZ(q) partial structure factors using
the Concentration-Concentration SCC(q) and the Number-Concentration SNC(q):

SZZ(q) =
SCC(q)
cAcB

and SNZ(q) =
SNC(q)
cB/ZA

(E.23)

cA and ZA represent the concentration and the charge of the chemical species A, the
global neutrality of the system must be respected therefore cAZA+ cBZB = 0.

Figure E.6 illustrates, and allows to compare, the partial structure factors of glassy GeS2
at 300 K calculated in the different formalism Faber-Ziman [14], Ashcroft-Langreth
[15, 16, 17], and Bhatia-Thornton [18].
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Figure E.6 Partial structure factors of glassy GeS2 at 300 K. A Faber-Ziman [14], B Ashcroft-
Langreth [15, 16, 17] and C Bhatia-Thornton [18].

atomes can compute all types of partial structure factors: Faber-Ziman SFZ
αβ (q), Ashcroft-

Langreth SAL
αβ (q) and Bhatia-Thornton SNN(q), SNC(q), SCC(q) and SZZ(q).
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E.4 Local atomic coordination properties

Several properties related to the atomic bonds and angles between them can be com-
puted using atomes. The existence or the absence of a bond between two atoms i of
species α and j of species β is determined by the analysis of the partial gαβ(r) and total
g(r) radial distribution functions. Precisely atomes will consider that a bond exists if the
interatomic distance Di j is smaller than both the cutoff given to describe the maximum
distance for first neighbor atoms between the species α and β, Rcutαβ (often the first
minimum of gαβ(r)), and the first minimum of the total radial distribution function,
Rcuttot.
atomes allows the user to specify both Rcutαβ and Rcuttot to choose an appropriate
description of the atomic bonds in the system under study. When atomic bonds in a
model are defined properly other structural characteristics can be evaluated, as follows:

E.4.1 Average first coordination numbers

atomes computes total as well as partials coordination numbers.

Figure E.7 Coordination numbers.

E.4.2 Individual atomic neighbor analysis

atomes computes the fraction of each type of coordination spheres in the model. The
presence of of structural defects can lead to a wide number of local environments,
figure E.8 illustrates the different coordination spheres found in a GeS2 glass.

Figure E.8 Illustration of several coordination spheres that can be found in glassy GeS2.
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E.4.3 Proportion of tetrahedral links and units in the structure model

Often the structure of a material is represented using building blocks. One of the the
most frequently occurring building blocks are tetrahedra. Figure E.9 shows a model of
GeS2 materials using GeS4 tetrahedra as building blocks.

Figure E.9 Illustration of the presence of GeS4 tetrahedra in the GeS2 material’s family. a)
GeS4 tetrahedra, representations b) of the α-GeS2 crystal and c) of the GeS2 glass
using tetrahedra.

atomes computes the fraction of the different tetrahedra in materials, the distinction
between these tetrahedra being made on the nature of the connection between each of
them. Tetrahedra can be linked either by corners or edges [Fig. E.10], atomes computes
the fraction of atoms forming tetrahedra as well as to the fraction of linked tetrahedra.

Figure E.10 Corner sharing (left) and edge sharing (right) tetrahedra.
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E.4.4 Distribution of bond lengths for the first coordination spheres

atomes gives access to the bond length distribution between first neighbor atoms
[Fig. E.11]:

Figure E.11 Nearest neighbor distances distribution.

E.4.5 Angles distributions

atomes also computes the distributions of bond angles and dihedral angles [Fig. E.12]:

Figure E.12 Bond angles (left) and diehdral angles (right).
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E.5 Ring statistics

The analysis of the topology of network-type structure models (liquid, crystalline or
amorphous systems) is often based on the part of the structural information which can
be represented in the graph theory using nodes for the atoms and links for the bonds.
The absence or the existence of a link between two nodes is determined by the analysis
of the total and partial radial distribution functions of the system.
In such a network a series of nodes and links connected sequentially without overlap
is called a path. Following this definition a ring is therefore simply a closed path. If we
study thoroughly a specific node of this network we see that this node can be involved
in numerous rings. Each of these rings is characterized by its size and can be classified
based upon the relations between the nodes and the links which constitute it.

E.5.1 Size of the rings

There are two possibilities for the numbering of rings. On the one hand, one can use
the total number of nodes of the ring, therefore a N-membered ring is a ring containing
N nodes. One the other hand, one can use the number of network forming nodes (ex:
Si atoms in SiO2 and Ge atoms in GeS2 which are the atoms of highest coordination
in these materials) an N-membered ring is therefore a ring containing 2×N nodes. For
crystals and SiO2-like glasses the second definition is usually applied. Nevertheless the
first method has to be used in the case of chalcogenide liquids and glasses in order to
count rings with homopolar bonds (ex: Ge-Ge and S-S bonds in GeS2) - See section E.5.5
for further details.
From a theoretical point of view it is possible to obtain an estimate for the ring of
maximum size that could exist in a network. This theoretical maximum size will
depend on the properties of the system studied as well as on the definition of a ring.

E.5.2 Definitions

E.5.2.1 King’s shortest paths criterion

The first way to define a ring has been given by Shirley V. King [19] (and later by
Franzblau [20]). In order to study the connectivity of glassy SiO2 she defines a ring as
the shortest path between two of the nearest neighbors of a given node [Fig. E.13].

Figure E.13 King’s criterion in the ring statistics: a ring represents the shortest path between
two of the nearest neighbors (N1 and N2) of a given node (At).
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In the case of the King’s criterion one can calculate the maximum number of different
ring sizes, NSmax(KSP), which can be found using the atom At to initiate the search:

NSmax(KSP) =
Nc(At)× (Nc(At)−1)

2
(E.24)

where Nc(At) is the number of neighbors of atom At. NSmax(KSP) represents the number
of ring sizes found if all couples of neighbors of atom At are connected together with
paths of different sizes.
It is also possible to calculate the theoretical maximum size, TMS(KSP), of a King’s
shortest path ring in the network using:

TMS(KSP) = 2 × (Dmax − 2) × (Ncmax − 2) + 2 × Dmax (E.25)

where Dmax is the longest distance, in number of chemical bonds, separating two atoms
in the network, and Ncmax represents the average number of neighbors of the chemical
species of higher coordination. If used when looking for rings, periodic boundary
conditions have to be taken into account to calculate Dmax. The relation [Eq. E.25] is
illustrated in figure E.16-2).

E.5.2.2 Guttman’s shortest paths criterion

A later definition of ring was proposed by Guttman [21], who defines a ring as the
shortest path which comes back to a given node (or atom) from one of its nearest neigh-
bors [Fig. E.14].

Figure E.14 Guttman’s criterion in the ring statistics: a ring represents the shortest path
which comes back to a given node (At) from one of its nearest neighbors (N).

Differences between the King and the Guttman’s shortest paths criteria are illustrated
in figure E.15.
Like for the King’s criterion, with the Guttman’s criterion one can calculate the maxi-
mum number of different ring sizes, NSmax(GSP), which can be found using the atom
At to initiate the search:

NSmax(GSP) =Nc(At)−1 (E.26)

where Nc(At) is the number of neighbors of atom At. NSmax(GSP) represents the number
of ring sizes found if the neighbors of atom At are connected together with paths of
different sizes.
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Figure E.15 Differences between the King and the Guttman shortest paths criteria for the
ring statistics in an AB2 system. In these two examples the search is initiated
from chemical species A (blue square). The nearest neighbor(s) of chemical
species B (green circles) are used to continue the analysis. 1) In the first example
only rings with 4 nodes are found using the Guttman’s criterion, whereas rings
with 18 nodes are also found using the King’s criterion (29 rings with 18 nodes).
2) In the second example the King’s shortest path criterion allows to find the
ring with 8 nodes ignored by the Guttman’s criterion which is only able to find
the rings with 6 nodes.

It is also possible to calculate the Theoretical Maximum Size, TMS(GSP), of a Guttman’s
ring in the network using:

TMS(GSP) = 2 × Dmax (E.27)

where Dmax represents the longest distance, in number of chemical bonds, separating
two atoms in the network. If used when looking for rings, periodic boundary conditions
have to be taken into account to calculate Dmax. The relation [Eq. E.27] is illustrated in
figure E.16-1.
Since the introduction of the King’s and the Guttman’s criteria other definitions of rings
have been proposed. These definitions are based on the properties of the rings to be
decomposed into the sum of smaller rings.

E.5.2.3 The primitive rings criterion

A ring is primitive [22, 23] (or Irreducible [24]) if it can not be decomposed into two
smaller rings [Fig. E.17].
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Figure E.16 Theoretical maximum size of the rings for an AB2 system (Ncmax = NcA = 4)
and using: 1) the Guttman’s criterion, 2) the King’s criterion. The theoretical
maximum size represent the longest distance between two nearest neighbors 1
and 2 (green circles) of the atom At used to initiate the search (blue square).

Figure E.17 Primitive rings in the ring statistics: the ’AC’ ring defined by the sum of the A
and the C paths is primitive only if there is no B path shorter than A and shorter
than C which allows to decompose the ’AC’ ring into two smaller rings ’AB’
and ’AC’.

The primitive rings analysis between the paths in figure E.17 may lead to 3 results
depending on the relations between the paths A, B, and C:

• If paths A, B, and C have the same length: A = B = C then the rings ’AB’, ’AC’
and ’BC’ are primitives.

• If the relation between the paths is like ? =? <? (ex: A = B < C) then 1 smaller
ring (’AB’) and 2 bigger rings (’AC’ and ’BC’) exist. None of these rings can be
decomposed into the sum of two smaller rings therefore the 3 rings are again
primitives.

• If the relation between the path is like ? <? =? (ex: A < B = C) or ? <? <? (ex: A
< B < C) then a shortest path exists (A). It will be possible to decompose the ring
(’BC’) built without this shortest path into the sum of 2 smaller rings (’AB’ and
’AC’), therefore this ring will not be primitive.
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E.5.2.4 The strong rings criterion

The strong rings [22, 23] are defined by extending the definition of primitive rings. A
ring is strong if it can not be decomposed into a sum of smaller rings whatever this
sum is, ie. whatever the number of paths in the decomposition is.

Figure E.18 Strong rings in the ring statistics: a) the 9-carbon-atoms ring created after
breaking a C-C bond in a Buckminster fulleren molecule is a counterexample
of strong ring; b) the combination of shortest rings, 11 5-carbon-atoms rings
and 19 6-carbon-atoms rings, appears easily after the deformation of the C60
molecule.

By definition the strong rings are also primitives, therefore to search for strong rings
can be summed as to find the strong rings among the primitive rings. This technique is
limited to relatively simple cases, like crystals or structures such as the one illustrated
in figure E.18. On the one hand the CPU time needed to complete such an analysis for
amorphous systems is very important. On the other hand it is not possible to search for
strong rings using the same search depth than for other types of rings. The strong ring
analysis is indeed diverging which makes it very complex to implement for amorphous
materials.
In the case of primitive rings like in the case of strong rings, there is no theoretical
maximum size of rings in the network.
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E.5.3 Description of a network using ring statistics - existing tools

Ring statistics are mainly used to obtain a snapshot of the connectivity of a network.
Thereby the better the snapshot will be, the better the description and the understand-
ing of the properties of the material will be. In the literature many papers present
studies of materials using ring statistics. In these studies either the number of Rings
per Node ’RN’ [34, 35] or the number of Rings per Cell ’RC’ [36, 37, 38] are given as
a result of the analysis. The first (RN) is calculated for one node by counting all the
rings corresponding to the property we are looking for (King’s, Guttman’s, primitive
or strong ring criterion). The second (RC) is calculated by counting all the different
rings corresponding at least once (at least for one node) to the property we are looking
for (King’s, shortest path, primitive or strong ring criterion). The values of RN and RC

are often reduced to the number of nodes of the networks. Furthermore the results are
presented according to each size of rings.
An example is proposed with a very simple network illustrated in figure E.19.

Figure E.19 A very simple network.

This network is composed of 10 nodes, arbitrary of the same chemical species, and 7
bonds. Furthermore it is clear that in this network there are 1 ring with 3 nodes and 1
ring with 4 nodes.
It is easy to calculate RN and RC for the network in figure E.19 (n = number of nodes):

n RN(n)

3 1/10
4 1/10

n RC(n)

3 3/10
4 4/10

Table E.1 RN and RC for the network in figure E.19

In the literature the values of RN and RC are usually given separately [34, 35, 36, 37, 38].
Nevertheless these two properties are not sufficient in order to describe a network
using rings. A simple example is proposed in figure E.20.

The two networks [Fig. E.20-a] and [Fig. E.20-b] do have very similar compositions
with 10 nodes and 7 links but they are clearly different. Nevertheless the previous
definitions of rings per cell and rings per node even taken together will lead to the
same description for these two different networks [Tab. E.2].
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Figure E.20 Two simple networks having very close compositions: 10 nodes and 7 links.

n RN(n)

3 1/10
4 1/10

n RC(n)

3 3/10
4 4/10

Table E.2 RN and RC calculated for the networks illustrated in figure E.20.

In both cases a) and b) there are 1 ring with 3 nodes and 1 ring with 4 nodes. It has
to be noticed that these two rings have properties which correspond to each of the
definitions introduced previously (King, Guttman, primitive and strong).
Thus none of these definitions is able to help to distinguish between these two net-
works. Therefore even though these simple networks are different, the previous
definitions lead to the same description.

Thereby it is justified to wonder about the interpretation of the data presented in the
literature for amorphous systems with a much higher complexity.

E.5.4 Rings and connectivity: the R.I.N.G.S. method implemented in

atomes

In the atomes program the results of the ring statistics analysis are outputted following
the new R.I.N.G.S. method [25, 39], this method is presented in the next pages.

The first goal of ring statistics is to give a faithful description of the connectivity of
a network and to allow to compare this information with others obtained for already
existing structures. It is therefore important to find a guideline which allows to
establish a distinction and then a comparison between networks studied using ring
statistics. We propose thereafter a new method to achieve this goal. First of all we
noticed fundamental points that must be considered to get a reliable and transferable
method:

1. The results must be reduced to the total number of nodes in the network.
The nature of the nodes used to initiate the analysis when looking for rings will
have a significant influence, therefore it is essential to reduce the results to a value
for one node. Otherwise it would be impossible to compare the results to the
ones obtained for systems made of nodes (particles) of different number and/or
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nature.

2. Different networks must be distinguishable whatever the method used to define a ring.
Indeed it is essential for the result of the analysis to be trustworthy indepen-
dently of the method used to define a ring (King, Guttman, primitives, strong).
Furthermore this will allow to compare the results of these different ring statistics.

E.5.4.1 Number of rings per cell ’RC’

We have already introduced this value, which is the first and the easiest way to compare
networks using ring statistics.

Figure E.21 The first comparison element: the total number of rings in the network.

n RC(n)

3 1/10
4 1/10

n RC(n)

3 0/10
4 2/10

Table E.3 Number of rings in the simple networks represented in figure E.21.

In the most simple cases, such as the one represented in figure E.21, the networks can
be distinguished using only the number of rings [Tab. E.3]. Nevertheless in most of
the cases other information are needed to describe accurately the connectivity of the
networks.

E.5.4.2 Description of the connectivity: difference between rings and nodes

The second information needed to investigate the properties of a network using rings
is the evaluation of the connectivity between rings. Indeed the distribution of the ring
sizes gives a first information on the connectivity, nevertheless it can not be exactly
evaluated unless one studies how the rings are connected. The impact of the relations
between rings, already presented in figure E.20, has been illustrated in detail in fig-
ure E.22. Figure E.22 represents the different possibilities to combine 2 rings with 6
nodes and 1 ring with 4 nodes in a network composed of 16 nodes.

Among the 9 networks presented in figure E.22 none can be distinguished using the RC

value [Tab. E.4].
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Figure E.22 The 9 different networks with 16 nodes, composed of 2 rings with 6 nodes and
1 ring with 4 nodes.

n RC(n)

4 1/16
6 2/16

Table E.4 Number of rings for the different networks presented in figure E.22.

Furthermore it is not possible to distinguish these networks using the RN value.
It seems possible to isolate the case a) [Tab. E.5] from the other cases b)→ i) [Tab. E.5].
Nevertheless the results obtained using the primitive rings criterion are similar for all
cases a)→ i) [Tab. E.5], this is in contradiction with the second statement [2] proposed
in our method.

Before introducing parameters able to distinguish the configurations presented in
figure E.22 it is important to wonder about the number of cases to distinguish. From
the point of view of the connectivity of the rings, configurations a), b), c) and d) are
clearly different. Nevertheless following the same approach configurations e) and
f) on the one hand and configurations g), h) and i) on the other hand are identical.
A schematic representation [Fig. E.23] is sufficient to illustrate the similarity of the
relations between these networks. The difference between each of these networks does
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Case a) RN(n)
n King / Guttman. Primitive / Strong.

4 4/16 4/16
6 10/16 12/16

Cases b)→ i) RN(n)
n All criteria.

4 4/16
6 12/16

Table E.5 Number of rings per node for the networks presented in figure E.22.

not appear in the connectivity of the rings but in the connectivity of the particles.

Figure E.23 Schematic representation of cases g) → i) (1) and e) → f) (2) illustrated in
figure E.22.

Thus among the networks illustrated in figure E.22 six dispositions of the rings have to
be distinguished (a, b, c, d, e, g). The proportions of particles involved, or not involved,
in the construction of rings will become an important question.

The new tool defined in our method is able to describe accurately the infor-
mation still missing on the connectivity. It is a square symmetric matrix of size
(R− r+1)× (R− r+1), where R and r represent respectively the bigger and the smaller
size of a ring found when analyzing the network: we have called this matrix the
connectivity matrix [Tab. E.6].

Cmat =





PN(r) PN(r+1,r) · · · PN(R,r)

PN(r,r+1) . . . PN(R,r+1)
...

. . .
...

PN(r,R) · · · · · · PN(R)





Table E.6 General connectivity matrix.

The diagonal elements PN(i) of this matrix represent the Proportion of Nodes at the
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origin of at least one ring of size i. And the non-diagonal elements PN(i, j) represent
the Proportion of Nodes at the origin of ring(s) of size i and j.
The matrix elements have a value ranging between 0 and 1. The lowest and non equal
to 0 is of the form 1

Nn , the highest and non equal to 1 is of the form Nn−1
Nn , where Nn

represents the number of nodes in the network.

King / Guttman. Primitive / Strong.

Cas a)

[

4/16 2/16
2/16 5/16

] [

4/16 4/16
4/16 7/16

]

All criteria.

Case b)

[

4/16 0/16
0/16 12/16

]

Case c)

[

4/16 1/16
1/16 12/16

]

Case d)

[

4/16 0/16
0/16 11/16

]

Case e)→ f)

[

4/16 2/16
2/16 12/16

]

Case g)→ i)

[

4/16 1/16
1/16 11/16

]

n= ring with n nodes
[

n4 n6/n4
n4/n6 n6

]

Table E.7 General connectivity matrix for the networks represented in figure E.22 and stud-
ied using the different definitions of rings.

The connectivity matrix of the configurations illustrated in figure E.22 are presented in
table E.7. We see that this matrix allows to distinguish each network whatever the way
used to define a ring is. This matrix remains simple for small systems (crystalline or
amorphous) or when using a small maximum ring size for the analysis. Nevertheless
its reading can be considerably altered when analysing amorphous systems with a
high maximum ring size for the analysis.

To simplify the reading and the interpretation of the data contained in this matrix
for more complex systems, we chose a similar approach to extract information on
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the connectivity between the rings. As a first step we decided to evaluate only the
diagonal elements PN(n) of the general connectivity matrix. Indeed these values allow
us to obtain a better view of the connectivity than the standard RN value.

PN(n)
n King / Guttman. Primitive / Strong.

Case a)

4 4/16 4/16
6 5/16 7/16

PN(n)
n All criteria.

Case b)→ c)

4 4/16
6 12/16

Case d)

4 4/16
6 11/16

Case e)→ f)

4 4/16
6 12/16

Case g)→ i)

4 4/16
6 11/16

Table E.8 PN(n) - Proportion of nodes at the origin of at least one ring of size n for the
networks in figure E.22.

It is clear [Tab. E.8] that using PN(n) improves the separation between the networks
illustrated in figure E.22. Nevertheless PN(n) does not allow to distinguish each of them.
We notice that the distinction between networks is improved [Tab. E.8] in particular
when compared to the one obtain with RN(n) [Tab. E.5].
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Therefore in a second step we chose to calculate two properties whose definitions
are very similar to the one of PN(n). The first, named PNmax(n), represents the pro-
portion of nodes for which the rings with n nodes are the longest closed paths found
using these nodes to initiate the search. The second named, PNmin(n), represents the
proportion of nodes for which the rings with n nodes are the shortest closed paths
found using these nodes to initiate the search.
The terms longest and shortest path must be considered carefully to avoid any confusion
with the terms used in section E.5.2 to define the rings. For one node it is possible to
find several rings whose properties correspond to the definitions proposed previously
(King’s, Guttman’s, primitive or strong ring criterion). These rings are solutions found
when looking for rings using this particular node to initiate the analysis. In order to
calculate PNmax(n) and PNmin(n) the longest and the shortest path have to be determined
among these different solutions.
PNmax(n) and PNmin(n) have values ranging between 0 and PN(n). The lowest and non
equal to 0 is of the form 1

Nn , the highest and non equal to 1 is of the form Nn−1
Nn , where

Nn represents the total number of nodes in the network. For the minimum ring size,
smin, existing in the network or found during the search, PNmin

(smin) = PN(smin). In the
same way for the maximum ring size, smax, existing in the network or found during
the search, PNmax(smax) = PN(smax).

To clarify these information it is possible to normalize PNmax(n) and PNmin(n) by
PN(n). By reducing these values we obtain, for each size of rings, values independent
of the total number of nodes Nn of the system. Then for a considered ring size the
values only refer to the number of nodes where the search returns rings of this size:

Pmax(n) =
PNmax(n)

PN(n)
and Pmin(n) =

PNmin
(n)

PN(n)

The normalized terms Pmax(n) and Pmin(n) have values ranging between 0 and 1. The
lowest and non equal to 0 is of the form 1

Nn , the highest and non equal to 1 is of the
form Nn−1

Nn . For the minimum ring size, smin, existing in the network or found during
the search, Pmin(smin) = 1. In the same way for the maximum ring size, smax, existing in
the network or found during the search, Pmax(smax) = 1.
Pmax(n) and Pmin(n) give complementary information to the ones obtained with RC(n)
and PN(n) in order to distinguish and compare networks using ring statistics. We can
illustrate this result by presenting the complete information obtained with this method
[Tab. E.9] for the networks represented in figure E.22.
Pmax(n) and Pmin(n) give information about the connectivity of the rings with each
other as a function of their size. If a ring of size n is found using a particular node to
initiate the search, Pmax(n) gives the probability that this ring is the longest ring which
can be found using this node to initiate the search. At the opposite, Pmin(n) gives the
probability that this ring is the shortest ring which can be found using this node to
initiate the search.
Thereafter we will use the terms ’connectivity profile’ to designate the results of a ring
statistics analysis. This profile is related to the definition of rings used in the search
and is made of the 4 values defined in our method: RC(n), PN(n), Pmax(n) and Pmin(n).
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King / Guttman.
n RC(n) PN(n) Pmax(n) Pmin(n)

Case a)

4 1/16 4/16 0.5 1.0
6 2/16 5/16 1.0 0.6

Primitive / Strong.
n RC(n) PN(n) Pmax(n) Pmin(n)

Case a)

4 1/16 4/16 0.5 1.0
6 2/16 7/16 1.0 3/7

All criteria.
n RC(n) PN(n) Pmax(n) Pmin(n)

Case b)

4 1/16 4/16 1.0 1.0
6 2/16 12/16 1.0 1.0

Case c)

4 1/16 4/16 0.75 1.0
6 2/16 12/16 1.0 11/12

Case d)

4 1/16 4/16 1.0 1.0
6 2/16 11/16 1.0 1.0

Case e)→ f)

4 1/16 4/16 0.5 1.0
6 2/16 12/16 1.0 10/12

Case g)→ i)

4 1/16 4/16 0.75 1.0
6 2/16 11/16 1.0 10/11

Table E.9 Connectivity profiles results of the ring statistics for the networks presented in
figure E.22.

The atomes program provides access to the connectivity profile of the system un-
der study and allows to choose the study the connectivity using all the different
methods used to define a ring. Thus King’s rings, Guttman’s rings, Primitive rings as
well as Strong rings analysis are available.
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E.5.5 Bond defects in ring statistics

E.5.5.1 ABAB and BABA rings

The ring statistics of amorphous networks are often focused on finding rings made
of a succession of atoms with an alternation of chemical species, called ABAB rings.
The most common examples come from the alternation of Si and O atoms (in silica
polymorphs) or Ge and S (in GeS2 polymorphs). These solids are usually built with
tetrahedra (SiO4 or GeS4) therefore we study the network distribution of tetrahedra.
The ideal technique to setup the analysis of such systems is to choose the atoms of
highest coordination to initiate the search, respectively Si in SiO2 and Ge in GeS2. In
most cases all rings can be found using this method. Nevertheless we can demonstrate
that some solutions, so some rings, can be ignored by this analysis. This is highlighted
in figure E.24 which represents a cluster of atoms isolated from an AB2 amorphous
network.

Figure E.24 Cluster of atoms isolated from an AB2 amorphous network. A bond defect is
located on an atom of the chemical species B (blue square). When looking for
King’s shortest paths [S. E.5.2.1] using the chemical species A to initiate the
search the central ring with 10 nodes is ignored. However among the solutions
of the analysis (with the initial nodes circled in green) other rings with 10 nodes
are found in the network.

We can see that this piece of network is characterized by a bond defect. An atom of
the B species appears to be over-coordinated by three atoms of the A species. When
looking for rings, using the King’s criterion [S. E.5.2.1] and initiating the search using
the A atoms, the central ring with 10 nodes is ignored. Nevertheless other rings with
10 nodes are found and stored as solutions of the analysis. In order to find the central
ring the search has to be initiated from the overcoordinated B atom.
By analogy with the terminology ABAB this ring can be called a BABA ring. Indeed the
alternation of chemical species is well respected. Therefore it is legitimate to question
the relevance of the analysis without this result. In other words we have to check out
if this BABA ring is, or not, an ABAB ring.
The properties of this ring meet the definition and can therefore improve the description
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of the connectivity of the network. This kind of coordination defect [Fig. E.24] is
uncommon in vitreous silica [34, 40], nevertheless it is frequent in chalcogenide glasses
[41, 42].

E.5.5.2 Homopolar bonds

In amorphous materials the homopolar bond defects can have a significant influence
on the ring statistics. This is true in particular for AB2 chalcogenide glasses. Figure E.25
illustrates standard cases that may be encountered when looking for rings in an AB2
system which contains homopolar bonds.

Figure E.25 Illustration of the influence of homopolar bonds in ABAB rings: in both examples
the smallest rings found when initiating the search using the circled nodes (green
color) contain an homopolar bond A-A or B-B.

The smallest rings found when initiating the search using the circled nodes (green
color) are not ABAB rings. Therefore their size must be given using the total number
of nodes. In figure E.25 the smallest rings are a ring with 9 nodes and a ring with
11 nodes containing respectively an A-A and a B-B homopolar bond. These rings are
significantly smaller than the shortest ABAB ring with 18 nodes that may be found
when looking for rings using the same green-circled nodes to initiate the analysis
[Fig. E.25].

The atomes program provides options to take into account or avoid A-B-A-B rings as
well as homopolar bonds.

E.5.6 Number of rings not found and that "potentially exist"

One of the first information it is possible to extract from ring statistics, except the
number of rings, is the number of rings not found by the analysis. Indeed calculation
times do strongly depend on the maximum search depth, ie. the maximum size of
a ring. To carry out the analysis this value has to be chosen to get the best possible
compromise between CPU time and quality of the description.
Nevertheless whatever this limiting value is, some rings of a size bigger than the
maximum search depth may not be found by the analysis. In the King E.5.2.1 and
the Guttman’s criteria E.5.2.2 it is possible to evaluate the number of "potentially not
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found" rings or rings that "potentially exist".
Thus for a given atom At we can consider that a closed path exists and is not found:

1. If the atom At has at least 2 nearest neighbors

2. If no closed path is found:

a- Starting from one neighbor to go back on the considered atom At (Guttman’s
criterion)

b- Between one couple of neighbors of the atom At (King’s criterion)

3. If the 2 nearest neighbors of the atom At have at least 2 nearest neighbors (to
avoid non bridging atoms)

Thus if during the analysis these 3 conditions are full filled (1, 2-a, 3 for the Guttman’s
criterion, and 1, 2-b, 3 for the King’s criterion) then we can say that this analysis has
potentially missed a ring between the neighbors of atom At. The smaller this number
of "potentially" missed rings will be the better this analysis will be and the better the
description of the connectivity of the material studied will be. The term "potentially"
has been chosen because the method only allows to avoid first neighbor non bridging
atoms.

Following this method atomes gives access to the number of rings that "potentially
exist" and not found during the analysis.
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E.6 Chain statistics

To get information on the connectivity of a material one can also rely on chain statistics.
The idea of this calculation is to look for path between 2 atoms A and B, respecting the
following rules:

• Total coordination for A (α) must be , 2

• Total coordination for B (β) must be , 2

• Total coordination for all atom(s) between A and B must be equal to 2.

Chains are then litteraly succession of atoms isolated from the rest of the material.
atomes offers several options to enforce specific definition of a chain for the search:

• Total coordination for A and B can be restricted to 1: searching for chains would
mean searching for isolated 1 dimensional (on a coordination point of view)
structures in the material.

• The chemistry of the atoms in the chain(s) can be considered:

– Only searching for AAAA (αααα) chains (homopolar bonds exclusively).

– Excluding homopolar bonds from the search (heteropolar bonds exclu-
sively).

– Only searching for ABAB (αβαβ) chains (perfect alternate of heteropolar
bonds.

E.7 Invariants of spherical harmonics as atomic order pa-

rameters

Invariants formed from bond spherical harmonics allow to obtain quantitative infor-
mation on the local atomic symmetries in materials. The analysis starts by associating
a set of spherical harmonics with every bond linking an atom to its nearest neighbors.
For a given bond defined by a vector ~r a spherical harmonic may be defined as:

Qlm(~r) = Ylm〈θ(~r),ψ(~r)〉 (E.28)

where Ylm(θ,ψ) is the spherical harmonic associated to the bond, θ and ψ are the angu-
lar components of the spherical coordinates of the bond which Cartesian coordinates
are defined by ~r.

Because the Qlm for a given l can be scrambled by changing to a rotated coordi-
nate system, it is important to consider rotational invariant combinations, such as
[26, 43]:

Ql =





4π
2l+1

l∑

m=−l

∣
∣
∣Q̄lm

∣
∣
∣
2




1/2

(E.29)
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where Q̄lm is defined by:
Q̄lm = 〈Qlm(~r)〉 (E.30)

and represents an average of the Ylm(θ,ψ) over all~r vectors in the system whether these
vectors belong to the same atomic configuration or not. Just as the angular momentum
quantum number, l, is a characteristic quantity of the ’shape’ of an atomic orbital,
the quantity Ql is a rotationally invariant characteristic value of the shape/symmetry
of a given local atomic configuration (if the average is not taken on all bonds of the
system but only within a given configuration) or an average of such values for a set of
configurations. Thus it is possible to compare Ql’s computed for well known crystal
structures (e.g. FCC, HFC ...) and some local atomic configurations in a material’s
model. The results of the comparison gives information for the presence/absence of a
particular local atomic symmetry.

atomes allows to compute the average Ql’s for each chemical species as well as
the average Ql’s for a user specified local atomic coordination.

E.8 Mean square displacement of atoms

Atoms in solids, liquids and gases move constantly at any given temperature, i.e. they
are subject to a "thermal" displacement from their average positions. This displacement
is particularly important in the case of a liquids. Atomic displacement does not follow a
simple trajectory: "collisions" with other atoms render atomic trajectories quite complex
shaped in space.
The trajectory followed by an atom in a liquid resembles that of a pedestrian random
walk. Mathematically this represents a sequence of steps done one after another where
each step follows a random direction which does not depend on the one of the previous
step (Markov’s chain of events).
In the case of a one-dimensional system (straight line) the displacement of the atom
will therefore be either a forward step (+) or a backward step (-). Furthermore it will
be impossible to predict one or the other direction (forward or backward) since they
have an equal probability to occur.
One can conclude that the distance an atom may travel is close to zero. Nevertheless
if we choose not to sum the displacements themselves (+/-) but the square of these
displacements then we will end up with a non-zero, positive quantity of the total
squared distance traveled. Consequently this allows to obtain a better evaluation of
the real (square) distance traveled by an atom.
The Mean Square Displacement MSD is defined by the relation:

MSD(t) = 〈r2(t)〉 =
〈

|ri(t)− ri(0)|2
〉

(E.31)

where ri(t) is the position of the atom i at the time t, and the 〉 〈 represent an average on
the time steps and/or the particles.
However, during the analysis of the results of molecular dynamics simulations it is
important to subtract the drift of the center of mass of the simulation box:

MSD(t) =
〈

|ri(t)− ri(0)− [rcm(t)− rcm(0)]|2
〉

(E.32)
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where rcm(t) represents the position of the center of mass of the system at the time t.
The MSD also contains information on the diffusion of atoms. If the system is solid
(frozen) then MSD "saturate", and the kinetic energy is not sufficient enough to reach a
diffusive behavior. Nevertheless if the system is not frozen (e.g. liquid) then the MSD
will grow linearly in time. In such a case it is possible to investigate the behavior of the
system looking at the slope of the MSD. The slope of the MSD or the so called diffusion
constant D is defined by:

D = lim
t→∞

1
6t
〈r2(t)〉 (E.33)

atomes provides access to the several MSD related functions:

• MSD for each chemical species with autocorrelation on all the dynamics

• MSD for each chemical species without autocorrelation on all the dynamics (step
by step)

• Directional MSD (x, y, z, xy, xz, yz) for each chemical species with autocorrelation
on all the dynamics

• Directional MSD (x, y, z, xy, xz, yz) for each chemical species without autocorre-
lation on all the dynamics (step by step)

• Drift of the center of mass (x, y, z)

• Correction applied to correct the drift of the center of mass in equation [Eq. E.32]
(x, y, z)
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The chemical properties database in
atomes

A database of chemical/physical properties is included in the atomes program, this
appendix presents these properties (atomic radii, x-ray and neutron scattering lengths)
as well as the references of the articles from which this information was obtained.
Note that the data presented in this appendix is available for download on the web site
of the program:

https://atomes.ipcms.fr

F.1 Atomic radii

F.1.1 Covalent radii
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Figure F.1 Covalent radii used in the atomes program.
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Figure F.1 presents the covalent radii used in atomes see [44] for details.

F.1.2 Ionic radii
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Figure F.2 Ionic radii used in the atomes program.

Figure F.2 presents the ionic radii used in atomes see [45] for details.

F.1.3 VDW radii
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Figure F.3 Van Der Waals radii used in the atomes program.

Figure F.3 presents the Van Der Waals radii used in atomes see [46] for details.
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F.1.4 Shannon radii in crystal
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Figure F.4 Shannon radii in crystals used in the atomes program.

Figure F.4 presents the Shannon radii in crystals used in atomes see [47, 48] for details.

F.2 Neutron scattering lenghts
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Figure F.5 Neutron scattering lengths used in the atomes program.

Figure F.5 presents the neutron scattering lengths used in atomes see [49, 50] for details.
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